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Chapter 1:

Introduction
Welcome to the DesignPro Tools for AFP Getting Started Guide. This guide is designed
to get you up and running with DesignPro Tools for AFP. This guide provides the
following:


Default installation, including installation of the system software and system
configuration.



DesignPro Tools Quick Start exercises, which will lead you through a few exercises
for hands-on experience with DesignPro Form Editor, Elixir PrintDriver, and
DesignPro Visual PPFA.
In the Quick Start exercises, you will create and edit overlays. Then you will use
overlay, font, and image resources in PageDefs and FormDefs. You will also place
variable data on single and multiple page documents and proof your work –
onscreen!

This chapter defines who should use this guide, describes the guides within the DesignPro
Tools documentation set, and provides Elixir Customer Support and training information.

DesignPro Tools Overview
DesignPro Tools for AFP provides a Windows-based, visual design environment for the
rapid and cost-effective creation of resources and variable projects for the AFP print
environment. DesignPro Tools supports integrated OGL and PPFA editors that make it
easy to create and edit the overlays, fonts, images, and data layout needed for AFP
printing. Once designed, resources can be saved in the AFP Source or Object format.
Developed according to the published IBM Advanced Function Presentation (AFP)
standards, DesignPro Tools supports Record Format, as well as Traditional PageDefs and
enables the management and conversion of resources to different formats.
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Associated DesignPro Tools Applications
DesignPro Tools for AFP employs integrated applications and utilities to provide
advanced functionality for creating resources such as documents, overlays, fonts and
images for AFP jobs. Each application helps you create or modify one or more of these
necessary resources in a simple environment.
Following are the DesignPro Tools for AFP applications:
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DesignPro Form Editor: a page layout tool for creating and editing overlays using
native AFP, Windows, or Elixir resources. Overlays can be saved to source or object
code.



DesignPro Visual PPFA: an application development tool that generates PPFA
PageDefs and FormDefs without time-intensive coding. Visual PPFA also supports
the placement of variable data on single and multiple page documents. PageDefs and
FormDefs can be saved to source or object code.



DesignPro Manager: a Windows Explorer-based file management tool for
resources used in editing and creating overlays, graphics and fonts. It is also a central
launching area for the DesignPro Editors and other utilities.



DesignPro Graphics Editor: a bitmap editor that prepares scanned images for
printing. Images can be tiled into fonts to speed the printing process. Uses native
AFP, Windows or Elixir resources for bitmap editing.



DesignPro Font Editor: a raster font editor used to create and edit all AFP font
components (character sets, code pages and coded fonts). Easy to use editing tools
give you precise control over font design, including resizing, pixel editing, filtering,
and special effects. Outline fonts can also be opened, edited, and saved as Elixir or
AFP fonts.



Elixir PrintDriver Pro: a utility for “printing” Windows documents into overlays.
Windows documents can be opened in their original format and printed using the
Elixir PrintDriver into overlays. All supported formats can be created using the
PrintDriver.



Elixir Scout: a system service that watches directories for a file or an event to
perform any number of actions like launching an executable (EXE or COM), running
a batch file (BAT or CMD), or selecting a process (DLL).



Elixir Viewer: displays printstream and resource files.



AFPDS Tree: displays the hierarchical structure of AFPDS files and the binary data
contained in the structured field records.
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About This User Guide
This guide introduces you to DesignPro Tools. It provides assistance with system
installation and configuration and provides a few exercises to help you feel confident in
the use of DesignPro Tools. This guide is divided into four chapters:
Chapter 1: Introduction
Provides a general introduction to DesignPro Tools and the DesignPro Tools Getting
Started Guide.
Chapter 2: Installation
Includes system requirements, registering, and installing your software.
Chapter 3: Configuration
Introduces the concept of virtual folders and leads you through an exercise in setting up
virtual folders in the DesignPro Manager.
Chapter 4: Quick Start
Leads you through the DesignPro Form Editor, Elixir PrintDriver Pro, and Visual PPFA
using a set of sample applications.

Who Should Use This Guide?
This guide is for anyone who needs to create and edit AFP and PPFA resources for an AFP
printing environment. This includes IBM mainframe users and print bureaus hosting an
IBM printing environment.
This guide assumes you are already familiar with Microsoft Windows operations, printer
and font management operations and PC peripherals. You should also have access to
reference manuals for PC software and hardware, including any printers you are using for
the design and print processes.

Chapter 1: Introduction
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Related Guides
If you require further information about a specific topic or wish to obtain product
background information, reference the following resources, all of which are part of the
DesignPro Tools for AFP documentation package.


DesignPro Tools Manager for AFP User Guide



DesignPro Tools Form Editor for AFP User Guide



DesignPro Tools Visual PPFA User Guide



DesignPro Tools Font Editor for AFP User Guide



DesignPro Tools Graphics Editor for AFP User Guide



DesignPro Tools for AFP Migration Guide

Conventions
Elixir products adhere to Microsoft Windows conventions for using menus, menu
commands, dialogs, command buttons, icons and mouse. See your Windows manual for
more information.
This guide uses the following typographic and symbolic conventions to identify special
information.

Typographic Conventions
The typographic conventions used in this guide are given below:

Convention

Information Type/Example

Bold type

Text for you to enter.
Field names, windows, toolbars, buttons and workspace areas within a
task step.
Example: select an item from the List of Used Fonts.
Example: click the Options tab.
Example: use rules set by the Start on option.
Example: select the Text tool.
Example: click OK to save settings.

Italic type

References to other documents and books.
Example: refer to the DesignPro Tools Form Editor for AFP User
Guide.
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Symbolic Conventions
Look for the following symbols as you read through this guide to identify special
information.

The Note symbol calls your attention to additional information.

The Tip symbol highlights a helpful tip.

The Shortcut symbol calls your attention to an easier way of accomplishing a
task.

The Warning symbol warns you of problems you might encounter.

The Migrating Users symbol provides notes and tips for anyone migrating from
a previous version of DesignPro Tools.

The Question symbol refers you to the online help for more information.
To open online help:

Chapter 1: Introduction



From the Help menu, select Help Topics, or



Click

in an open dialog
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Getting the Answers You Need
Elixir Technologies provides you with multiple ways to learn and use DesignPro Tools:


Customer Support (page 12)



Elixir Web Site (page 13)



Elixir Training (page 13)



Product Help (page 13)



Release Notes (page 14)

Customer Support
If you purchased this product directly from Elixir Technologies, you can contact the
Customer Support Center for your region at the number listed below.
If you have purchased this product from some other source, please contact the
authorized support representative from that source. Elixir provides customer
support for products purchased directly from Elixir.

North and South America:


+1 805 641 5900 ext. 3, Monday - Friday, 7:00 am to 4:00 pm Pacific Standard Time;
if closed, press 2 to reach Elixir’s extended Support coverage.



ELX_support@elixir.com

Asia Pacific:


Asia_support@elixir.com

Europe:
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+44 (0) 207 993-4811, Monday - Friday, 6:00 am to 4:00 pm Central European Time



+1 805 641 5900 ext. 3, Monday - Friday, 4:00 pm to 2:00 am Central European
Time



Europe_support@elixir.com
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An Elixir Product Specialist will take your call and ask for the following information:


Your name, organization, telephone number and address.



Elixir product name and version number.



A complete description of the problem, including any error messages printed or
displayed on your monitor.

Elixir Web Site
You can obtain product support from the Elixir web page at www.elixir.com.
Select Support to:


Ask a question of Elixir Support.



Download the latest product releases and patches.



View the latest product Release Notes.



Sign up for Elixir Training.



Renew your product license.

Elixir Training
Elixir Technologies offers training for its full-range of Windows-based products. For more
information, contact Elixir Learning at +1 805 641 5900, ext. 4.

Product Help
Elixir software uses the Microsoft Windows Help program to provide online help for all
product functions.
This online tool includes step-by-step procedures that you can follow as you work.


Context-Sensitive Help can be activated from within the software for certain
dialogs by clicking



in the top right corner of a dialog.

Online Help can be opened from any component from the Help menu by selecting
Help Topics.

Chapter 1: Introduction
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Release Notes
Release Notes display at the start of product installation so you can review them before
beginning the installation process. Once installation completes, you can access Release
Notes from the product CD at drive:\Relnotes. There are two formats of the Release Notes
file: Relnotes.pdf and Relnotes.txt. The TXT file can be viewed using either Notepad or
WordPad. The PDF file can be viewed using Adobe Reader.

14
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Chapter 2:

Installation
In this chapter...


System Requirements



Installing DesignPro Tools



Installing DesignPro Tools in Silent Mode

This chapter guides you through the installation and registration processes of DesignPro
Tools for AFP. It describes the system requirements necessary to install and run DesignPro
Tools on your computer.
This chapter also describes procedures for upgrading to, repairing, and uninstalling
DesignPro Tools version 3.00.

System Requirements
The minimum system requirements for running DesignPro Tools are:

Software Requirements
To run DesignPro Tools, you need one of the following operating systems installed on
your computer:


Windows XP with Service Pack 1.0a or higher.



Windows 2000 Professional with Service Pack 3.0 or higher.



Windows NT 4.0 with Service Pack 6.0a or higher.

The application also requires Internet Explorer 5.5 or above.

Internet Explorer 5.5 is required whether or not you have an Internet
connection.
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Hardware Requirements
You need the following minimum hardware specifications to run DesignPro Tools on your
computer:


Processor: 350 MHZ Pentium required, Pentium III or higher recommended.



RAM: 128 MB required, 256 MB recommended.



Hard disk space: 10 GB (with 650 MB free space for Windows 2000 or Windows
NT, and 1.5 GB free space for Windows XP).



VGA or SVGA monitor that supports 1024 x 768 screen resolution or higher.

Print Servers and Compilers
AFP resources created in DesignPro Tools for AFP utilize features made available in
recent upgrades to the AFP architecture. In order to support these updated resource
features, the following minimum versions of IBM products must be installed (where
applicable):

Product

Version

InfoPrint Manager for
Windows

2.1.0.20

InfoPrint Manager for
AIX

4.1.0.40

Print Services Facility
(PSF) for OS/390

3.2.0

Comments

Print Services Facility for
OS/400
Print Services Facility for
VM
Print Services Facility for
VSE
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Product

Version

Comments

Overlay Generation
Language (OGL)

V1R1

PTFs for the following
APARs must be applied:
PN71601, PN72016

Page Printer Formatting
Aid (PPFA)

V1R1

PTFs for the following
APARs must be applied:
PQ37413, PQ44225,
PQ45264, PQ49491,
PN74144, PQ03978,
PQ07878, PQ20307,
PQ29466, PQ29466,
PQ40831, PQ43723,
PQ52083, PQ57237

Installing DesignPro Tools
This section provides instructions for installing DesignPro Tools for AFP.

Only user accounts with administrative rights can perform install -related tasks.

It is highly recommended that you close all programs before you install or
uninstall any software.

Chapter 2: Installation

17

To install DesignPro Tools for AFP:

1

Insert the DesignPro Tools CD into your CD-ROM drive.
If your computer is set up to automatically run a CD, the Welcome to DesignPro
Tools screen displays.

The Welcome to DesignPro Tools screen.
If your computer is not set up to automatically run a CD, you will need to run the
installation manually.

18

2

From the Start menu, select Run.

3

Type drive:\Setup.exe (replace drive with the letter of your CD-ROM drive) and
click OK.
The Welcome to DesignPro Tools screen displays.
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4

Select DesignPro Tools for AFP.
This selection installs the AFP version of DesignPro Tools. If you want to install
both the AFP and Xerox versions, select DesignPro Tools Professional.
The DesignPro Tools setup prepares the InstallShield Wizard.

The Setup initializes.
The DesignPro Tools for AFP Wizard displays.

The DesignPro Tools for AFP Wizard.

5

Select Run Password Registration Process.
If selected, the password registration process runs automatically after the installation.

Chapter 2: Installation
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6

Click Next.
The License Agreement dialog displays.

Read the License Agreement carefully before proceeding.
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7

Read the License Agreement carefully.

8

If you agree, click Yes.
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The Setup Type dialog appears.

Choose the type of setup you prefer in the Setup Type dialog.

9

As appropriate, select one of the following:
 Typical
Installs all services and components; displays the Customer Information dialog.
 Custom
Allows customized selection of components and services; displays Customer
Information dialog and then Select Components dialog.

10 Click Next.
For specific options on selecting Custom components, see “Select Components” on page
23.
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The Customer Information dialog displays.

Enter your information and continue.

11 In the User Name entry box, enter your name.
12 In the Company Name entry box, enter your company’s name.

These entries are pre-filled using the default information from your PC. You can
change this information if needed.

13 Click Next.
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Select Components
The Select Components dialog displays if Custom was selected from the Setup dialog in
step 9. This dialog lists all available services and components.

Selecting DesignPro Tool components to install.

14 Select required services and components, then click Next.
You can also install Elixir PrintDriver Pro and Elixir Scout components
seperately. To do so, insert the DesignPro Tools CD into your CD-ROM drive.
From the Start menu, select Run. Enter one of the following:


Drive:\Scout\Setup.exe to install Elixir PrintDriver Pro (replace drive
with the letter of your CD-ROM drive).

or
Drive:\PrintDrv\Setup.exe to install Elixir Scout Manager (replace drive
with the letter of your CD-ROM drive).
Click OK to install the specified component..


Chapter 2: Installation
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Complete DesignPro Tools Installation, Continued
The Choose Destination Location dialog displays.

Setting the DesignPro Tools for AFP installation location.

15 Browse to select the folder for DesignPro Tools executables and DLLs if you want to
change the default directory.
The default path for DesignPro Tools application files is different than the Elixir
Application Suite directory path. This allows you to run both applications at the
same time. For more information, refer to the DesignPro Tools Migration for AFP
Guide.

16 Browse to select the folder for Elixir documents and resources if you want to change
the default directory.
If you are currently using Elixir Application Suite, you can choose from one of
the two folder configurations:
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You can use your existing directory structure; existing resource folders will
be kept intact. Or,
You can create a new directory structure by browsing to a new directory
location other than drive:\Elixir.
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17 Click Next.
The Select Program Folder dialog displays with Elixir Applications\DesignPro Tools
set as the default folder for placing application shortcuts.

Selecting the Program Folder for DesignPro Tools.

In this dialog, you can either create a new Program folder for DesignPro Tools
shortcuts or select from the existing folders listed.

Chapter 2: Installation
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18 Click Next.
The Log on As dialog displays.

Using system log on information.
By default, the Log on as System Account option is selected and all the other fields are
made unavailable. Proceeding with these settings will use your PC’s log on information.
The Log on As dialog does not display when installing Elixir PrintDriver Pro only.
However, in Windows NT the Log on As dialog displays when installing Elixir
PrintDriver Pro.

You will need to change the default log on settings if you want to log on using a
different login ID (other than the one you are currently logged on with). Logging
on with a local machine/domain account will restrict DesignPro Tools use to
authorized users only.

To customize the log on options, uncheck the Log on as System Account option and enter
your information in the available fields.

26
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19 Uncheck Log on as System Account.

Adding log on information.

20 Specify your domain from the Domain drop-down list.
21 Enter your User ID in the User entry box.
If you would like a list of users within a chosen domain, select Enumerate domain
users. Then select a User ID from the drop-down list. This should be the User ID
that you would want to use when logging onto the PC to work with DesignPro Tools.
If DesignPro Tools is installed using one login ID, and then you login under
another ID, you will need to create a new profile using the Profile Editor. A new
default profile is not automatically created for new users.

22 Enter your password in the Password entry box.
This should be the same password used to login.

23 Enter your password again in the Confirm Password entry box.

Chapter 2: Installation
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24 Click Next.
The Start Copying Files dialog displays with the current setting details.

Review the Current Settings details before starting the installation.
The wizard confirms your settings before it starts copying DesignPro Tools files. If you
need to make any changes to these settings, click Back.

25 If you agree with the settings, click Next.
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The Setup Status dialog displays with the installation’s progress.

DesignPro Tools for AFP installs.
Once the installation completes, you will be prompted to unlock DesignPro Tools for
use.

Starting the software registration process as part of the installation.

26 Click Yes.

This dialog displays only if Run password registration process is selected at
the start of the installation process.

Chapter 2: Installation
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If you want to run registration as a separate process, click No. When you are
ready to register, open the Start menu and choose All Programs,Elixir
Applications, DesignPro Tools, Product Registration.

Registering DesignPro Tools
Elixir Technologies Corporation provides licenses to use purchased copies of DesignPro
Tools. The easiest method for unlocking your software is using the Internet. Connect to
the Internet at this point to start the registration process.
You can continue with the registration process even if you are not connected to
the Internet. Other options for registering are given in the last dialog of
registration.

If you are not registering as part of the installation process, product registration
is available in the DesignPro Tools program folder. When you are ready to
register, open the Start menu and choose All Programs, Elixir
Applications, DesignPro Tools, Product Registration.

The Elixir Product Registration dialog displays.

The Elixir Product Registration process begins.

30
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27 Click Next.
The registration process continues.

The Machine Serial number is automatically obtained from your PC.

Every computer has a unique, system-generated Machine Serial number. This
dialog only requires the Customer Number provided with your Customer
Activation Letter.

28 In the Customer Number entry box, enter your Customer Number and click Next.

Enter your password and PC Number from the Customer Activation Letter sent with
your software.

Chapter 2: Installation
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29 Type in your Password and PC Number.
Elixir Technologies creates specific software registrations based on the unique
combination of Customer Number, PC Number, and Password. This information
is provided in the Customer Activation Letter.

30 Click Next.
The dialog displays a selection of registration choices.

Select a method for the product registration.
You can select one of the following from this dialog:
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Download the Product License via Internet:
• See “Preparing and Downloading Initial Product License from the Internet” on
page 33.
• See “Downloading Existing Product License from the Internet” on page 35.



Prepare the Product License if Not Connected to the Internet:
Contact “Customer Support” on page 12 for assistance.
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View the Product License:
See “Viewing the Product License Information” on page 35.



Deactivate the Product License:
See “Deactivating the Product License File” on page 36.

Preparing and Downloading Initial Product License from the
Internet
31 Select Prepare and download my initial product license registration. This
workstation or another pc is connected to the internet.
The Registration wizard communicates your licensing information with Elixir
Technologies using your Internet connection.

You will need to connect to the Internet before continuing with the registration
process.

32 Click Next.
The Download Password dialog prompts if the PC is connected to the Internet.

Chapter 2: Installation
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33 In the Download Password dialog, click one of the following options:
Option

Result

Yes

The license information downloads and displays in the dialog.

No

If your PC or another PC available is not connected to the Internet, you
can contact “Customer Support” on page 12 for getting the product
license.
The Elixir Product Specialist will ask for the following information:


Your name, customer number, organization, telephone number
and address.



Elixir product name and version number.



Your machine serial and PC number.

Clicking Yes displays the following dialog:

The license information downloads and displays in the Elixir Product Registration
dialog on clicking Yes.

Make sure the product information listed is correct. If you have any questions or
concerns, contact “Customer Support” on page 12 for assistance.

34
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34 Click Save.
The Elixir Product Registration dialog displays.

Your product registration process is complete.

35 Click Finish to save the license file Password.epw at
drive:\Program Files\Elixir Technologies\Bin.

Downloading Existing Product License from the Internet
If you are already a licensed user and want to renew your product license, request
Customer Support for license renewal and select Download My Existing License
Registration from the dialog. If you are connected to the Internet, the updated license file
will download at drive:\Program Files\Elixir Technologies\Bin\.

Viewing the Product License Information
To view information regarding the existing product license on your machine:

36 Select Display License Information for This Workspace, and then click Next.
The information provided by your selected license key or license server is displayed
in the Elixir Product Registration dialog. The information includes the Machine
Serial, Customer Number, Password, PC Number, Unlock Codes, Qty, Expire,
Product Name, Version, and PC Unlock Code.

37 Click Print to print the information for future reference.
The print command is sent to the default printer set on your machine.

Chapter 2: Installation
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38 Perform any of the following steps in the dialog:




Click Back to modify the information in the Elixir Product Registration dialog.
Or
Click Save to save the product license file Password.epw at
drive:\Program Files\Elixir Technologies\Bin\.
Upon saving the file, the Product Registration Wizard confirms that the license is
saved on your machine.

Make sure that the product information listed is correct. If you have any
questions or concerns, contact “Customer Support” on page 12 for assistance.

39 Click Finish to exit the Product Registration Wizard.

Deactivating the Product License File
If you select Deactivate License File for This Workspace from the Elixir Product
Registration dialog, the license and your customer password is permanently disabled
from your machine.

It is recommended to contact “Customer Support” on page 12 if you want to
deactivate the license from your machine.

After the registration process completes, if an earlier version of Elixir
Application Suite is detected on your system, you are given an option to place
the resources at the location where Elixir Application Suite resources are
already located.

36
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Continuing the Installation
The installation process continues displaying the Check/Uncheck to associate file
extensions dialog.

Creating file extension associations.

40 Select any file extensions you wish to associate with a DesignPro Tools editor.
41 Click Next.

Chapter 2: Installation
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The InstallShield Wizard Complete dialog displays.

The installation is complete.

42 Select Yes, I want to restart my computer now.
43 Click Finish.
The installation completes and the computer restarts.
If you do not receive a prompt to restart your PC, you may choose whether or
not to restart. The installation has completed without the necessity of
restarting. However, it is recommended that you restart your computer after
any software installation or upgrade.

44 Once the computer has restarted, you may remove the CD from the CD-ROM drive.

38
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Upgrading DesignPro Tools
To upgrade an existing installation of DesignPro Tools to DesignPro Tools 3.00, you can
run the Update process.

Only user accounts with administrative rights can perform install - related tasks.

Make sure you close all open programs before repairing or modifying a software
application.

1

Insert the DesignPro Tools CD into your CD-ROM drive.
If your computer is set up to automatically run a CD, the Welcome to DesignPro
Tools screen displays.

The Welcome to DesignPro Tools screen.

Chapter 2: Installation
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If your PC is not set up to automatically run CDs, open the Start menu and
select Run. Type drive:\Setup.exe (replace drive with the letter of your CDROM drive) and click OK.

2

Click DesignPro Tools for AFP.
This selection will update the AFP version of DesignPro Tools. If you want to update
both the AFP and Xerox versions, click DesignPro Tools Professional.
The DesignPro Tools setup prepares the InstallShield Wizard.

The Setup initializes.

To upgrade an existing installation, the installation program searches for a
previously installed version of the software.

40
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The DesignPro Tools for AFP Wizard displays.

The DesignPro Tools for AFP dialog.
You do not need to select the Run Password Registration Process option.

3

Click Next.
The License Agreement dialog displays.

Read the License Agreement carefully before proceeding.

Chapter 2: Installation
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4

Read the License Agreement carefully.

5

If you agree, click Yes.
The installation program searches for a previously installed version of the software.
If an earlier version of DesignPro Tools is found on your system, the install
automatically displays the Welcome dialog with the Modify, Update, and Remove
options.

The DesignPro Tools install detects that an earlier version of DesignPro Tools is
already installed.
The Modify option:


Uninstalls components from the present application.



Installs components not previously installed.

The Update option:


Upgrades the installed DesignPro Tools version to 3.00.

The Remove option:


42

Removes all installed components of DesignPro Tools.
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6

Select Update and click Next.
The Log on As dialog displays.

Using system log on information.
By default, the Log on as System Account option is selected and all fields are unavailable.
Proceeding with these settings will use your PC’s log on information.
You will need to change the default log on settings if you want to log on using a
different login ID (other than the one you are currently logged on with). Logging
on with a local machine/domain account will restrict DesignPro Tools use to
authorized users only.

To customize the log on options, uncheck the Log on as System Account option and enter
your information in the available fields:
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7

Uncheck Log on as System Account.

Adding logon information.

8

Specify your domain from the Domain drop-down list.

9

Enter your User ID in the User entry box.
If you would like a list of users within a chosen domain, select Enumerate domain
users. Then select a User ID from the drop-down list. This should be the User ID
that you would want to use when logging onto the PC to work with DesignPro Tools.

10 Enter your password in the Password entry box.
This should be the same password used to login to your domain.

11 Enter your password again in the Confirm Password entry box.
12 Click Next.
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The wizard performs the requested operation and updates the software to version
3.00. The upgrade status displays in the Setup Status dialog.

The Install updates the application.
Once the update procedure is complete, the Check/Uncheck to associate file
extensions dialog displays.

Creating file extension associations.
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13 Select any file extensions you wish to associate with a DesignPro Tools editor.
14 Click Next.
The Maintenance Complete dialog displays.

Maintenance is complete.

15 Click Finish.
The DesignPro Tools update process completes. The Welcome to DesignPro Tools
screen displays.

16 Click Exit to close the Welcome to DesignPro Tools screen.
If you do not receive a prompt to restart your PC, you may choose whether or
not to restart. The installation has completed without the necessity of
restarting. However, it is recommended that you restart your computer after
any software installation or upgrade.
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Modifying DesignPro Tools
To add new program components or to remove currently installed components, you can
run the Modify process.

Only user accounts with administrative rights can perform install - related tasks.

Make sure you close all open programs before repairing or modifying a software
application.

1

Insert the DesignPro Tools CD into your CD-ROM drive.
If your computer is set up to automatically run a CD, the Welcome to DesignPro
Tools screen displays.

The Welcome to DesignPro Tools screen.
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2

Click DesignPro Tools for AFP.
This selection will update the AFP version of DesignPro Tools. If you want to update
both the AFP and Xerox versions, click DesignPro Tools Professional.
If your PC is not set up to automatically run CDs, open the Start menu and
select Run. Type drive:\Setup.exe (replace drive with the letter of your CDROM drive) and click OK.

The DesignPro Tools setup prepares the InstallShield Wizard.

The Setup initializes.

To modify an existing installation of DesignPro Tools 3.00, the installation
program searches for a previously installed components of the software.
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The DesignPro Tools for AFP Wizard displays.

The DesignPro Tools for AFP dialog.
You do not need to select the Run Password Registration Process option.
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3

Click Next.
The installation program searches for a previously installed version of the software.
If an earlier version of DesignPro Tools is found on your system, the install
automatically displays the Welcome dialog with the Modify, Repair, and Remove
options.

The DesignPro Tools for AFP install detects an installed version of DesignPro Tools.
The Modify option:


Uninstalls components from the present application.



Installs components not previously installed.

The Repair option:


Repairs or refreshes damaged or missing files of the presently installed application.

The Remove option:


50

Removes all installed components of DesignPro Tools.

DesignPro Tools® for AFP Getting Started Guide

4

Select Modify and click Next.
The Select Components dialog displays.

The Select Components dialog allows you to install or uninstall program
components.

5

Select the required components for installation, and uncheck the components not
required.
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6

Click Next.
The wizard performs the requested operation and installs/uninstalls the specified
components. The maintenance status displays in the Setup Status dialog.

The Installer is adding and/or removing the required components.
Once the modification procedure is complete, the Check/Uncheck to associate file
extensions dialog displays.

Creating file extension associations.
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7

Select any file extensions you wish to associate with a DesignPro Tools editor.

8

Click Next.
The DesignPro Tools repair process completes and the Maintenance Complete dialog
displays.

Maintenance is complete.

9

Select Yes, I want to restart my computer now and click Finish to close the dialog.

If you do not receive a prompt to restart your PC, you may choose whether or
not to restart. The maintenance completes without restarting.

It is recommended that you restart your computer after any software
installation or modification.
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Repairing DesignPro Tools
To repair DesignPro Tools for AFP, or to reinstall missing or damaged files, you can run
the Repair process.

Only user accounts with administrative rights can perform install -related tasks.

Make sure you close all open programs before repairing or modifying a software
application.

1

Insert the DesignPro Tools CD into your CD-ROM drive.
If your computer is set up to automatically run a CD, the Welcome to DesignPro
Tools screen displays.

The Welcome to DesignPro Tools screen.
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If your PC is not set up to automatically run CDs, open the Start menu and
select Run. Type drive:\Setup.exe (replace drive with the letter of your CDROM drive) and click OK.

2

Click DesignPro Tools for AFP.
This selection repairs the AFP version of DesignPro Tools. If you want to repair both
the AFP and Xerox versions, select DesignPro Tools Professional.
The DesignPro Tools setup prepares the InstallShield Wizard.

The Setup initializes.
The DesignPro Tools for AFP Wizard displays.

The DesignPro Tools for AFP dialog.
You do not need to select the Run Password Registration Process option.
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3

Click Next.
The installation program searches for a previously installed version of the software.
If an earlier version of DesignPro Tools is found on your system, the install
automatically displays the Welcome dialog with the Modify, Repair, and Remove
options.

The DesignPro Tools for AFP install detects an installed version of DesignPro Tools.
The Modify option:


Uninstalls components from the present application.



Installs components not previously installed.

The Repair option:


Repairs or refreshes damaged or missing files of the presently installed application.

The Remove option:
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4

Select Repair and click Next.
The Log on As dialog displays.

Using system log on information.
By default, the Log on as System Account option is selected and all fields are unavailable.
Proceeding with these settings will use your PC’s log on information.
You will need to change the default log on settings if you want to log on using a
different login ID (other than the one you are currently logged on with). Logging
on with a local machine/domain account will restrict DesignPro Tools use to
authorized users only.

To customize the log on options, uncheck the Log on as System Account option and enter
your information in the available fields:
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5

Uncheck Log on as System Account.

Adding logon information.
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6

Specify your domain from the Domain drop-down list.

7

Enter your User ID in the User entry box.
If you would like a list of users within a chosen domain, select Enumerate domain
users. Then select a User ID from the drop-down list. This should be the User ID
that you would want to use when logging onto the PC to work with DesignPro Tools.

8

Enter your password in the Password entry box.
This should be the same password used to login to your domain.

9

Enter your password again in the Confirm Password entry box.
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10 Click Next.
The wizard performs the requested operation and repairs the damaged files or
reinstalls the software. The maintenance status displays in the Setup Status dialog.

The Install repairs the application.
Once the repair procedure is complete, the Check/Uncheck to associate file
extensions dialog displays.

Creating file extension associations.
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11 Select any file extensions you wish to associate with a DesignPro Tools editor.
12 Click Next.
The Maintenance Complete dialog displays.

Maintenance is complete.

13 Click Finish.
The DesignPro Tools repair process completes. The Welcome to DesignPro Tools
screen displays.

14 Click Exit to close the Welcome to DesignPro Tools screen.

If you do not receive a prompt to restart your PC, you may choose whether or
not to restart. The maintenance completes without restarting.

It is recommended that you restart your computer after any software
installation.
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Uninstalling DesignPro Tools
To uninstall DesignPro Tools for AFP, you will run the Remove process.

Only user accounts with administrative rights can perform install related tasks.

Prior to removing DesignPro Tools, close all open programs.

To uninstall DesignPro Tools:

1

Insert the DesignPro Tools CD into your CD-ROM drive.
If your computer is set up to automatically run a CD, the Welcome to DesignPro
Tools screen displays.

The Welcome to DesignPro Tools screen.
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If your PC is not set up to automatically run CDs, open the Start menu and
select Run. Type drive:\Setup.exe (replace drive with the letter of your CDROM drive) and click OK.

2

Click DesignPro Tools for AFP.
The DesignPro Tools setup prepares the InstallShield Wizard.

The Setup initializes.
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The DesignPro Tools for AFP Wizard displays.

The DesignPro Tools for AFP dialog.
You do not need to select the Run Password Registration Process option.
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3

Click Next.
The installation program searches for a previously installed version of the software.
If a previous version of DesignPro Tools is found installed on your system, the install
automatically displays the Welcome dialog with the Modify, Repair and Remove
options.

Select Remove to uninstall all DesignPro Tools software components.

4

Select Remove and click Next.
The Confirm Uninstall dialog displays.

Confirming the uninstall request.
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Confirming this option will remove all installed components of DesignPro Tools.

5

Click OK.
The Confirm Uninstall dialog displays.

Confirming the uninstall process for Elixir PrintDriver Pro and Elixir Scout.
Confirming this option will also remove Elixir PrintDriver Pro, Elixir Scout, and utilities
of the DesignPro Tools software package.

6

Click Yes.
The Setup Status dialog displays and begins removing DesignPro Tools.
The Shared File Detected dialog displays.

The Shared *.dll files are detected.
Shared DLL files are detected that may no longer be needed in any application.

It is recommended to remove these shared files with the software.

7

Select Don’t display this message again.
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8

Click Yes.
The DesignPro Tools for AFP Setup removes all components. The Setup Status
dialog displays the progress.

The Setup Status displays the uninstall progress.
Once all DesignPro Tools application files are removed from your computer, the
wizard displays the Maintenance Complete dialog.

DesignPro Tools for AFP is removed from your computer.
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9

Click Finish.
DesignPro Tools is uninstalled from your PC. The Welcome to DesignPro Tools
screen displays.

10 Click Exit to close the Welcome to DesignPro Tools screen.

DesignPro Tools resource folders are not removed with the application files.

If you do not receive a prompt to restart your PC, you may choose whether or
not to restart. The maintenance completes without restarting.

It is recommended that you restart your computer after any software uninstall.
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Installing DesignPro Tools in Silent Mode
DesignPro Tools now provides silent installation feature. This is a two step process; first
the installation process is carried out in Record mode. The installation process is run once
to capture the necessary installation and configuration parameters that will be provided in
an ISS file.

An ISS file contains a set of parameters that represent installation and
configuration specifications.

Secondly the installer is run on a machine in Silent mode. The installer picks up the
installation and configuration specifications from the ISS file. Silent installation results in
the exact installation and configuration specifications being used on all machines.
You can also use the silent installation feature to run such procedures as upgrading to,
repairing, modifying, and uninstalling using DesignPro Tools version 3.00.

Only user accounts with administrative rights can perform install related tasks.

Prior to installing DesignPro Tools, close all open programs.

To install DesignPro Tools for AFP in Record mode:
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1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the Command Prompt.

3

Change the directory to drive:\DPTools
Replace drive with the letter of your CD-ROM drive.
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4

Enter Setup.exe /r /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /r or -r switch is used to run the install in Record mode and /f1 or -f1 switch
specifies the ISS file (DPTools.iss). Specify the directory where the ISS file created
is to be placed. If an ISS file is not specified then Setup.iss file is created by default
and is placed in the drive:\Windows Directory.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC switch specifies the
Scout ISS file (Scout.iss). Specify the directory where the ISS files are to be placed.
If a directory is not provided, then these files are placed on the system’s root drive.

The ISS files used for installing can not be used for any other procedures such as
upgrading to, modifying, repairing and uninstalling of DesignPro Tools.

Installing DesignPro Tools for AFP in Record mode.
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5

Press [Enter].
The DesignPro Tools setup prepares the InstallShield Wizard and the installation
process runs. For more information on the installation process, refer to “Installing
DesignPro Tools” on page 17.
DesignPro Tools always prompts to restart the machine after the completion of
installation in Record mode. Once the installation is complete the next step is to
unlock DesignPro Tools for use. For more information, refer to “Registering
DesignPro Tools” on page 30.

Once the installation process is complete, the DesignPro Tools is installed on the system
and the ISS files created are placed in the directory specified in step 4.
You can also run the installation process using the sample batch file
DPTRecordMode_Inst.bat provided with the install. Run the batch file to install
DesignPro Tools in Record mode; the ISS files created are placed by default in
the system’s root drive.

Elixir Application Suite Detection dialog always appear during installation in Record
mode even in the absence of Elixir Application Suite. This ensures that the Elixir
Application Suite settings can be saved on machines where Elixir Application Suite is
detected during installation in Silent mode.

Elixir Application Suite Detection dialog always appear during installation in Record
mode even in the absence of Elixir Application Suite.
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ElixiTag is supported by MS Word 2000 or higher. However ElixiTag utility is
installed in Record mode in the absence of MS Word 2000 or higher. This
enables the ElixiTag utility to be installed on a machine where MS Word 2000 or
higher is detected during installation in Silent mode.

To install DesignPro Tools for AFP in Silent mode:

1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the Command Prompt.

3

Change the directory to drive:\DPTools.
Replace drive with the letter of your CD-ROM drive.

4

Enter Setup.exe /s /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /s or -s switch is used to run the install in Silent mode and /f1 or –f1 switch
specifies the ISS file (DPTools.iss). Specify the directory where you have placed the
ISS file.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC specifies Scout ISS
file (Scout.iss). Specify the directory where you have placed the PrintDriver and
Scout ISS files.
Sample ISS files (Setup.iss, PrintDrv.iss, and Scout.iss) for installating DesignPro
Tools in Silent mode are provided with the install. These files are placed in their
respective program folders (DPTools, PrintDrv, and Scout) in the CD-ROM.
When using these sample files, you do not need to carry out the installation in
Record mode.
To install DesignPro Tools in Silent mode using the sample ISS files, place the ISS
files on a local drive and carry out steps 2 to 4 mentioned above.

The sample files provided with the install only allow you to install DesignPro
Tools Professional using the Typical installation mode.
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Installing DesignPro Tools for AFP in Silent mode.
The installation runs in silent mode.
You can also run the installation process in Silent mode using the batch file
DPTSilentMode_Inst.bat provided with the install.
To install DesignPro Tools using the batch file, place the sample ISS files
(Setup.iss, PrintDrv.iss, and Scout.iss) provided with the install on the system’s
root drive and run the batch file. DesignPro Tools is installed on the system.

Messages generated during the Silent mode installation are logged in the
Install.log file. The log file is placed in the drive:\Program Files\Elixir
Technologies\Bin Directory.
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Upgrading DesignPro Tools in Silent Mode
To upgrade DesignPro Tools for AFP in Record mode:

1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the Command Prompt.

3

Change the directory to CD-ROM drive:\DPTools
Replace drive with the letter of your CD-ROM drive.

Only user accounts with administrative rights can perform install related tasks.

Prior to upgrading DesignPro Tools, close all open programs.

4

Enter Setup.exe /r /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /r or -r switch is used to run the install in Record mode and /f1 or -f1 switch
specifies the ISS file (DPTools.iss). Specify the directory where the ISS file created
is to be placed. If an ISS file is not specified then Setup.iss file is created by default
and is placed in the drive:\Windows Directory.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC switch specifies the
Scout ISS file (Scout.iss). Specify the directory where the ISS files are to be placed.
If a directory is not provided, then these files are placed on the system’s root drive.

The ISS files used for upgrading can not be used for any other procedures such
as repairing, modifying, installing and uninstalling of DesignPro Tools.
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Upgrading DesignPro Tools for AFP in Record mode.

5

Press [Enter].
The DesignPro Tools setup prepares the InstallShield Wizard and the upgrading
process runs. For more information on the upgrading process, refer to “Upgrading
DesignPro Tools” on page 39.
DesignPro Tools always prompts to restart the machine after the completion of
maintenance in Record mode.

To upgrade DesignPro Tools for AFP in Silent mode:

1

Open the Command Prompt.

2

Change the directory to drive:\DPTools
Replace drive with the letter of your CD-ROM drive.

3

Enter Setup.exe /s /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /s or -s switch is used to run the install in Silent mode and /f1 or -f1 switch
specifies the ISS file (DPTools.iss). You also need to specify the directory where
you have placed the ISS file.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC specifies Scout ISS
file (Scout.iss). Specify the directory where you have placed the PrintDriver and
Scout ISS files.
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Upgrading DesignPro Tools for AFP in Silent mode.
The upgrading process runs in Silent mode.

Modifying DesignPro Tools in Silent Mode
To modify DesignPro Tools for AFP in Record mode:

1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the command Prompt.

3

Change the directory to drive:\DPTools.
Replace drive with the letter of your CD-ROM drive.

Only user accounts with administrative rights can perform install related tasks.

Prior to modifying DesignPro Tools, close all open programs.
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4

Enter Setup.exe /r /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /r or -r switch is used to run the install in Record mode and /f1 or -f1 switch
specifies the ISS file (DPTools.iss). Specify the directory where the ISS file created
is to be placed. If an ISS file is not specified then Setup.iss file is created by default
and is placed in the drive:\Windows Directory.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC switch specifies the
Scout ISS file (Scout.iss). Specify the directory where the ISS files are to be placed.
If a directory is not provided, then these files are placed on the system’s root drive.

The ISS files used for modifying can not be used for any other procedures such
as repairing, upgrading, installing and uninstalling of DesignPro Tools.

Modifying DesignPro Tools for AFP in Record mode.
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Press [Enter].
The DesignPro Tools setup prepares the InstallShield Wizard and the modification
process runs. For more information on the modification process, refer to “Modifying
DesignPro Tools” on page 47.
DesignPro Tools always prompts to restart the machine after the completion of
maintenance in record mode.
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To modify DesignPro Tools for AFP in Silent mode:

1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the Command Prompt.

3

Change the directory to drive:\DPTools
Replace drive with the letter of your CD-ROM drive.

4

Enter Setup.exe /s /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /s or -s switch is used to run the install in Silent mode and /f1 or -f1 switch
specifies the ISS file (DPTools.iss). You also need to specify the directory where
you have placed the ISS file.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC specifies Scout ISS
file (Scout.iss). Specify the directory where you have placed the PrintDriver and
Scout ISS files.

Modifying DesignPro Tools for AFP in Silent mode.
The modification process runs in Silent mode.
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Repairing DesignPro Tools in Silent Mode
To repair DesignPro Tools for AFP in Record mode:

1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the Command Prompt.

3

Change the directory to drive:\DPTools
Replace drive with the letter of your CD-ROM drive.

Only user accounts with administrative rights can perform install related tasks.

Prior to repairing DesignPro Tools, close all open programs.

4

Enter Setup.exe /r /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /r or -r switch is used to run the install in Record mode and /f1 or -f1 switch
specifies the ISS file (DPTools.iss). Specify the directory where the ISS file created
is to be placed. If an ISS file is not specified then Setup.iss file is created by default
and is placed in the drive:\Windows Directory.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC switch specifies the
Scout ISS file (Scout.iss). Specify the directory where the ISS files will be placed. If
a directory is not provided, then these files are placed on the system’s root drive.

The ISS files used for repairing can not be used for any other procedures such as
upgrading to, modifying, installing and uninstalling of DesignPro Tools.
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Repairing DesignPro Tools for AFP in Record mode.

5

Press [Enter].
The DesignPro Tools setup prepares the InstallShield Wizard and the repairing
process runs. For more information on the repairing process, refer to “Repairing
DesignPro Tools” on page 54.
DesignPro Tools always prompts to restart the machine after the completion of
maintenance in Record mode.

To repair DesignPro Tools for AFP in Silent mode:

1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the Command Prompt.

3

Change the directory to drive:\DPTools
Replace drive with the letter of your CD-ROM drive.

4

Enter Setup.exe /s /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
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The /s or -s switch is used to run the install in Silent mode and /f1 or -f1 switch
specifies the ISS files (DPTools.iss). You also need to specify the directory where
you have placed the ISS file.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC specifies Scout ISS
file (Scout.iss). Specify the directory where you have placed the PrintDriver and
Scout ISS files.

Repairing DesignPro Tools for AFP in Silent mode.
The repairing process runs in Silent mode.
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Uninstalling DesignPro Tools in Silent Mode
To uninstall DesignPro Tools for AFP in Record mode:

1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the Command Prompt.

3

Change the directory to CD-ROM drive:\DPTools
Replace drive with the letter of your CD-ROM drive.

Only user accounts with administrative rights can perform install related tasks.

Prior to removing DesignPro Tools, close all open programs.

4

Enter Setup.exe /r /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /r or -r switch is used to run the install in Record mode and /f1 or -f1 switch
specifies the ISS file (DPTools.iss). Specify the directory where the ISS file created
is to be placed. If an ISS file is not specified then Setup.iss file is created by default
and is placed in the drive:\Windows Directory.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC switch specifies the
Scout ISS file (Scout.iss). Specify the directory where the ISS files will be placed. If
a directory is not provided, then these files are placed on the system’s root drive.

The ISS files used for uninstalling can not be used for any other procedures such
as upgrading to, modifying, installing and repairing of DesignPro Tools.
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Uninstalling DesignPro Tools for AFP in Record mode.

5

Press [Enter].
The DesignPro Tools setup prepares the InstallShield Wizard and the uninstalling
process runs. For more information on the uninstalling process, refer to
“Uninstalling DesignPro Tools” on page 61.
DesignPro Tools always prompts to restart the machine after the completion of
uninstall process in Record mode.
You can also run the uninstall process using the sample batch file
DPTRecordMode_Uninst.bat provided with install. Run the batch file to uninstall
DesignPro Tools in Record mode; the ISS files created are placed on the system’s
root drive.

To uninstall DesignPro Tools for AFP in Silent mode:
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1

Insert the DesignPro Tools CD into your CD-ROM drive.

2

Open the Command Prompt.

3

Change the directory to drive:\DPTools
Replace drive with the letter of your CD-ROM drive.
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4

Enter Setup.exe /s /f1drive:\DPTools.iss /PDdrive:\PrintDrv.iss /
SCdrive:\Scout.iss
The /s or -s switch is used to run the install in Silent mode and /f1 or -f1 switch
specifies the ISS file (DPTools.iss). Specify the directory where you have placed the
ISS file. If an ISS file is not specified then Setup.iss file is created by default and is
placed in the drive:\Windows Directory.
For PrintDriver and Scout, separate ISS files are used. The /PD or -PD switch
specifies the PrintDriver ISS file (PrintDrv.iss) and /SC or -SC specifies Scout ISS
file (Scout.iss). Specify the directory where you have placed the PrintDriver and
Scout ISS files.
Sample ISS files (DPTools_Uninst.iss, PrintDrv_Uninst.iss, and Scout_Uninst.iss)
for uninstallating DesignPro Tools in Silent mode are provided with the install.
These files are placed in their respective program folders (DPTools, PrintDrv,
and Scout) in the CD-ROM. When using these sample files, you do not need to
carry out the uninstallation process in Record mode.
To uninstall DesignPro Tools in Silent mode using the sample ISS files, place the
ISS files on a local drive and carry out steps 2 to 4 mentioned above.

The sample files provided with the install only allow you to uninstall DesignPro
Tools Professional.
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Uninstalling DesignPro Tools for AFP in Silent mode.
The uninstall process runs in Silent mode.
You can also run the uninstallation process in Silent mode using the sample batch
file DPTSilentMode_Uninst.bat provided with the install.
To uninstall DesignPro Tools using the batch file, place the ISS files
(DPTools_Uninst.iss, PrintDrv_Uninst.iss, and Scout_Uninst.iss) provided with
the install on the system’s root drive and run the batch file.
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Chapter 3:

Configuration
In this chapter...


Understanding Virtual Folders



Adding Virtual Folders



Removing Virtual Folders

In this chapter, you will configure DesignPro Tools for AFP for your environment.
Configuration involves setting up virtual folders, that are used to organize, manage, and
maintain resources.
A resource is a file used for printing. A resource can be, but is not limited to, overlays,
fonts, page segments, PageDefs, and FormDefs. Each resource can exist in several
different formats. For example, an image might be scanned and saved as a BMP, then later
saved as a page segment. At some point, you might want to convert the original image into
another format for a different application. All of these resources require management,
which is accomplished using virtual folders.
In addition, system parsers, writers, and editors use virtual folders for locating resources.
When an overlay is opened in the Form Editor, the system parsers search the virtual folder
paths for fonts and images used in the overlay. If the resources are not located in the
defined virtual folders, the overlay opens with errors.
A folder structure supporting all file types is created during the Elixir software
installation. You can designate additional folders for each file type to work within your
current workflow.
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Understanding Virtual Folders
Virtual folders are an abstract representation of the physical file folder structure
underlying DesignPro Tools. Displayed as a tree structure in the Manager, virtual folders
are organized by resource type, then resource format. At the lowest level of each branch,
one or more folders are listed, each representing a physical location on a mapped drive.
You will start by reviewing the virtual folders that are available by default in the Manager.
From the Start menu, select All Programs, Elixir Applications, DesignPro Tools,
DesignPro Manager.
Manager opens:

Notice the hierarchy underneath the Elixir Resources node. These are virtual folders, or
file locations for resources.
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Manager displays four windows similar to Windows Explorer. The left most window is
the Navigation window that contains icons you can click to open the installed DesignPro
Tools applications and utilities. The Resource window displays a hierarchy of virtual
folders containing the Elixir resources while the Explorer window displays the hierarchy
of physical folders. The root of the virtual folder tree, named Elixir Resources, is at the
same level in the hierarchy as the Desktop root node of the physical Explorer tree.The
contents of the folder selected in either of the windows is shown in the center pane. The
Manage window, that provides various options for packaging and searching the Elixir
resources, appears at the right most corner.
Notice that there are default locations for Documents, Fonts, Forms, Graphics, and Jobs.
Each of these resource type folders contains the supported resource format folders.
Underneath the resource format folders (OVE, OGL, etc.), there are additional named file
folders, representing a physical location on your drive or network. These names are
automatically generated; however, you can change these names according to your
environment specifications. Placing your cursor over the mapped file folder displays the
absolute path of the virtual folder references.

Forms and overlays both describe the same resource type.

The virtual folder structure.
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Adding Virtual Folders
You may wish to add more folders for each resource type, depending on your
organization’s current workflow. You can map the same physical folder to several resource
formats. Folders are not restricted to just one resource format.
To add physical folders to the virtual folder structure:

1

Expand the folder structure and select a resource type.
For example, to map a new folder for AFP OVEs, expand the Forms, AFP, and OVE
folders using the sign next to the folder names.

2

Right-click a resource type node where you would like to map a new folder, and
select Map New Folder from the pop-up menu.
The Browse For Folder dialog displays.

Browse to a new physical location.

3

Browse to select a folder, and click OK.

You are selecting an existing physical folder location. This physical location will
be mapped to a virtual folder.
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The physical folder is mapped to the virtual folders tree structure and a folder entry
displays under the selected node. The folder is automatically named according to the
selected resource format. For example, if you mapped the new folder on the OVE resource
format, the folder will be named OVE2.
You can rename the recently mapped folder by typing in a new name. To rename the folder
at a later stage, right-click the folder and select Rename from the pop-up menu.

A new folder is added to the virtual folders tree.
Changes in the virtual folders are posted as profile entries to the SystemData.ini file, and
multiple profile files can be created to allow custom combinations of resource paths. If
you have multiple customers or projects requiring separate collections of resources, you
can create individual profiles for each collection of resources and activate those profiles
during resource editing sessions.
A profile is a part of the SystemData.ini file, which stores your preferences for
using DesignPro Tools. The profile specifically determines where and how
resources are opened, referenced, and saved.
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Removing Virtual Folders
To remove a virtual folder:

1

Right-click a mapped folder and select Unmap Folder from the pop-up menu.
The Unmap Folder dialog confirms your action.

The Unmap Folder message box.

2

Click Yes.
The folder is no longer mapped as a virtual folder.
This action does not delete the folder or any of the folder’s files. Unmapping a
folder only removes the folder reference from the active profile in DesignPro
Tools and removes the selected node from the virtual folder tree.
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Chapter 4:

Quick Start
In this chapter...


Understanding the Application



Opening the DesignPro Form Editor



Creating an Application



Using Elixir PrintDriver Pro to Create Overlays

Quick Start is designed to introduce you to the key areas of DesignPro Tools for AFP, so
you can start building your own designs and resources as soon as possible. This chapter
guides you through two exercises:


Creating a simple marketing letter design using Form Editor and Visual PPFA.



Developing an overlay using PrintDriver.

For the marketing letter, you will first create an overlay. The overlay includes static
images, text, and drawing objects such as lines and boxes. This is the information that
stays the same for all documents.
Once the overlay is complete, you will create a PageDef, which defines how variable data
is used on a page. A PageDef can include variable data directly from a dataset, fixed data
not on the overlay, or conditions. Conditions choose which PageFormat and CopyGroup
to use when there are multiple options. Then you will create a FormDef, which defines
how the design prints.
Once the overlay, PageDef and FormDef are complete, you will proof them with live data
directly on your PC. At the end of the exercise, all the resources will be ready for you to
upload to the host, compile, and print.
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In summary, to create the marketing letter, you will:


Use graphics, drawing objects, and text to create an overlay.



Create a PageDef using variable and fixed data.



Create a FormDef to specify how the letter will print.



Proof the project.



Save the resources for uploading to the host.

This design uses many object properties. For more information on a specific
property or function, refer to the DesignPro Tools Online Help.

Understanding the Application
Central Commercial Bank (CCB) offers highly personalized banking services to their
clients. Once a month, they send out letters to new clients, introducing their products and
services.
CCB needs a letter containing static text, graphic elements, and variable data. You will add
the static text and graphic elements to an overlay, and then use this overlay in Visual PPFA
to create a PageDef and a FormDef.
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The completed Central Commercial Bank letter.
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Opening the DesignPro Form Editor
To create the CCB design, you will use the Form Editor and Visual PPFA. You will start
with the Form Editor to create the overlay.

1

From the Start menu, select All Programs, Elixir Applications, DesignPro Tools,
DesignPro Form Editor.
Form Editor opens:

The Form Editor. 1. Menu bar. 2. Standard toolbar. 3. Zoom toolbar. 4. Position and
Dimension toolbar. 5. Common Attributes toolbar. 6. Filter toolbar. 7. Form template
toolbar. 8. Select toolbox. 9. Tools toolbar. 10. Design Area.

Forms and overlays are two words for the same resource object. Form Editor
creates overlays.
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Setting Page Properties
When you launch Form Editor, a new overlay opens with the Form Editor. Before adding
objects to the page, you will verify the page settings.

2

From the Tools menu, select Options.
The Options dialog displays.

3

Scroll down to view the Page sub-categories.

4

Select the Dimensions sub-category and select Letter in the Paper Size list, if it is
not already selected.

Setting Page properties in the Options dialog

This guide uses inches as the default measurement unit. If you want to use a unit
of measurement other than the default, select the Ruler category and select
your preference from the Units drop-down list.

5

Click Apply, and then click OK.
Keep the default value for all other settings.
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Adding an Image
Form Editor can insert AFP images into an overlay. You can also insert Windows formats,
such as BMPs and TIFFs, directly into the overlay without any pre-conversion.
If you decide to use an image format other than AFP, you will need to save the
image to AFP format before uploading the resource to the host. This can be done
when saving the overlay to AFP format. You do not have to convert each
resource separately.

DesignPro Tools can use native AFP resources directly in a resource editor. You
may still choose to use the Elixir version while editing, and then save as AFP
before uploading the finished resource or application to the host.

The first element on the overlay is the CCB logo. You will insert and position the image
on the page.

You can close the Manage window to create more space in the Design Area.
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6

On the Tools toolbar, click
.
The Open Resource File dialog displays.

The Open Resource File dialog.

7

In the Files of Type drop-down list, select AFP Page Segment (S1*) if it is not
already selected.

8

From the left pane, select the Elixir icon.
When you select the Elixir icon, the path automatically updates to the specified
profile’s directory for the selected Files of Type. For example, the default profile
lists drive:\Elixir\Pics\Afp as the directory for AFP Page Segments.

9

From the Insert As drop-down list, select Embedded.
This option embeds the resource into the overlay.
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10 Select S1CCLogo.seg and click Open.
A rectangle using the image dimensions displays in the Design Area. This rectangle
helps you visually place the image.

Rectangle using the selected image dimensions.

Resources can be located anywhere on your local drives or network. You can use
the default directories provided, or build your own directory structure using
virtual folders.

AFP architecture allows a maximum of eight characters for resource names. Each
resource has a two-character prefix, determined by the resource type, and up to
six additional characters for a user name. AFP page segments use the SI prefix.

11 Place the image in the upper left corner of the Design Area by clicking once.
A bounding rectangle displays around the CCB logo. Once you click in the Design
Area, the rectangle is replaced by handles at the top, bottom, and sides of the image.
The position coordinates and the size of the image display on the Position and Dimension
toolbar. These coordinates represent the top-left corner of the image.
The handles around the logo indicate that the image is selected. You can change the
position and size of the image by clicking and dragging. You can also position the logo by
entering the exact coordinates in the Position and Dimension toolbar.
The CCB design has a mockup that includes positioning coordinates. Throughout
this exercise, each object has a position assigned. You can specify the exact
coordinates for each object as they are listed, or you can create the overlay by
matching them visually to the application mockup at the beginning of the chapter.
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12 In the Position and Dimension toolbar, specify the following:
X: 0.25 in
 Y: 0.30 in
Use the Enter key to apply the coordinates.


The Position and Dimension toolbar. Type in the entry boxes to change the location
of a selected object. X is the horizontal coordinate, Y is the vertical coordinate, W is
the object width, and H is the object height.
You have repositioned the CCB logo.

The CCB logo displays in the Design Area.

You can move objects incrementally using the Position and Dimension toolbar.
You can also click and drag to position and resize images.
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Adding Text
AFP printing can use raster or outline fonts, depending on your printer’s capabilities. In
this exercise, you will use an outline font and convert it to an AFP raster font.

A raster font contains bitmaps of each character.

A raster font only contains one family, style, and point size per font. For example, Times
New Roman 12 point bold and Times New Roman 10 point bold are two separate fonts.
DesignPro Tools supports the following font types:


True Type fonts



Adobe Type Manager (ATM) fonts



Elixir legacy fonts (for previous Elixir Application Suite users)



AFP fonts

You will use font lists to organize fonts in overlays and PageDefs. It is a good idea to set
up the font list before adding text, although you can add or delete fonts as you create the
overlay.
For the CCB design you will use the CCB corporate font, Arial 11 point normal. This is
the default font used for Form Editor, so you do not need to set up a font list for this
application. You can start adding text to the overlay using the default font.

13 On the Tools toolbar, click
The cursor changes to

.

.

14 Click in the Design Area and type Dear.
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15 Right-click the text in the Design Area, and select Properties from the pop-up menu.
The Properties - Text dialog displays.
Form Editor provides object-sensitive property dialogs. To access the property
dialog for an object, right-click the object in the Design Area and select
Properties from the pop-up menu.

16 Select the Transformation category and specify the following properties:



X: 1.25 in
Y: 3.50 in

Position can be changed in the object’s property dialog from the Position and
Dimension toolbar or by clicking and dragging the object to a new location in the
Design Area.

17 Click Apply, and then click OK.
The text moves to the specified location. You have added the first text string to your
overlay.
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18 Click

.
This completes the text object insertion process and exits the text mode. You can also
click in an empty portion of the Design Area, or select any other tool to complete text
object insertion process and exit the text mode.

The first text object is positioned on the overlay.

It is important that you exit the text mode when you are finished with a text
object. If you stay in the edit mode, subsequent text that you type will display
with the current selected text object.
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Saving as an Elixir Form
It is a good idea to save your work often. You will now save your overlay.
You have two options for saving a form: Save and Save As. The Save option saves the
overlay with its current name, whereas the Save As option allows you to change the name
of the overlay. Since the overlay is currently untitled, it does not matter which you use.

19 From the File menu, select Save.

The Save As dialog.

20 From the Save As drop-down list, select Elixir Form (*.efr) if it is not already
selected.
You can also save your overlay as a source or compiled AFP overlay. For this
exercise, you are initially using the Elixir format. This format is useful for retaining
all formatting elements, as it supports a richer feature set than the AFP format. You
will save this overlay to the AFP Object format later in this exercise.

Chapter 4: Quick Start

103

21 From the left pane, select Elixir if it is not already selected.
The path automatically updates to drive:\Elixir\Forms\Elixir, the default profile’s
directory for Elixir overlays.

22 In the File Name entry box, enter CCBLET.
23 Click Save to save the overlay.

Importing Text
Many overlays are text-intensive. In order to avoid extensive typing in Form Editor, you
can create text files using word processing applications such as MS Word, WordPerfect,
Notepad, or any software that can export either a TXT or RTF format file. Form Editor can
import TXT and RTF files.
Now you will import the body of the letter using an RTF file.

24 From the Edit menu, select Import Text.
The Text Import dialog displays.

25 In the Files of Type drop-down list, select Rich Text Format (*.rtf).

The Intro.rtf file selected in the Text Import dialog.
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26 Browse to select drive:\Elixir\Gs\Intro.rtf and click Open.
The cursor changes to

with an attached rectangle representing the text area.

27 Position the text rectangle underneath ‘Dear’ in the Design Area and click once to
place the imported text.
The Intro.rtf text displays in the Design Area with a text box around the inserted text.
The fonts and margins of the RTF file import with the text.

You can also draw a text box before importing or typing text, that you can resize
later to match your requirements.

28 In the Position and Dimension toolbar, specify the following coordinates and size:




X: 1.25 in
Y: 3.80 in
W: 6.25 in

Use the Enter key to apply your settings for each coordinate to the text object.

29 On the Tools toolbar, click
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30 On the Text Attributes toolbox, click

, even if it is already selected.

The text justifies to the left side.

The Intro.rtf text is imported and positioned.
You have repositioned, resized, and justified the text for the body of the letter. Note that
the text automatically wraps to the next line when the line reaches the end of the text box.

31 Click

if it is not already selected.
The text object import is complete.

The next step is to import the bank contact information and place it at the bottom of the
letter.

32 Scroll to the bottom of the page.
33 From the Edit menu, select Import Text.
The Text Import dialog displays.
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34 In the Files of Type drop-down list, select Rich Text Format (*.rtf).
35 Browse to select drive:\Elixir\Gs\CCBContact.rtf, and click Open.
36 Click at the bottom of the document under the body of the letter to import the text.
Form Editor imports Rich Text Files with embedded formatting and font
information. Therefore, the imported RTF file displays with all of the formatting
applied in its original editor.

37 Specify the following in the Position and Dimension toolbar:
X: 1.90 in
Y: 8.90 in
 W: 5.00 in
The CCBContact text moves to the specified coordinates in the Design Area.



The CCBContact RTF file is imported and positioned in the Design Area.
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38 Click in an empty part of the Design Area to complete the text object.
The text object is complete.
The coordinates and positions were obtained using a ruler on the original
mockup. When designing your own overlays, you may need to measure a
mockup, or simply judge what looks best when placing text and other objects on
the page.

Editing Text
In the CCBContact text, notice that ‘Central Commercial Bank’ uses a normal style, but
the address directly below is bold. You will edit the text directly in the overlay and make
all of these text lines bold.
All of the fonts associated with the RTF are imported with the file. You will select the text
and apply the new font.
In the Elixir Application Suite, right-clicking an object allows you to edit the
object’s properties in the toolbox. In DesignPro Tools, toolbox properties are
editable for any selected object. Right-clicking an object opens a pop-up menu
from which the object’s properties dialog can be opened.
To edit text, double-click the text block in the Design Area and start editing.

39 Double-click anywhere in the CCBContact text box to open it for editing.
The cursor changes to

.

40 Highlight Central Commercial Bank in the text box.
41 In the Font Style drop-down list, select Arial 9, Bold.
The Arial 9, Bold and Arial 9 fonts imported with the RTF file. The highlighted text
changes according to the selected font style.

The Font Style drop-down list on the Text Attributes toolbar.
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42 Using the arrow keys, move the cursor to the end of ‘Central Commercial Bank’ and
press the Delete key five times on your keyboard.
This deletes the extra spaces and aligns the rest of the text correctly.

43 Using your arrow keys, move the cursor to the beginning of the line that contains
‘Outside California’.

Avoid using the Enter key to maintain the formatting of your imported text. The
Enter key adds lines to the text.

44 Select Arial 9, Bold from the Font Style drop-down list.
45 Enter www.CentralComBank.com.
The text formatting is complete.

The text in now correct.
You have completed inserting and editing text on your overlay. Now you will format the
text to fill more vertical space on the page by changing the line spacing.

46 Right-click the CCBContact text box in the Design Area and select Properties from
the pop-up menu.
The Properties – Text dialog displays.
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47 Select the Justification category and specify the following properties:



Line Spacing: Selected
LPI: 6.00

Setting line spacing in the Properties – Text dialog.

48 Click Apply, and then click OK.
The text justifies accordingly, adding more space between each line of text.

The line spacing changes as specified.

Adding Images
The basic layout of the overlay is complete with respect to the text. Next, you will add the
signature to the letter. Once again, you will use an AFP page segment for the image.

49 On the Tools toolbar, click

.
The Open Resource File dialog displays.

50 In the Files of Type drop-down list, select AFP Page Segment (S1*) if it is not
already selected.
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51 From the left pane, select Elixir.
The path automatically updates to drive:\Elixir\Pics\Afp, the default profile’s
directory for AFP page segments.

52 From the Insert As drop-down list, select Embedded if it is not already selected.
53 Select S1Miller.seg and click Open.
A rectangle with the signature’s dimensions displays in the Design Area.

54 Click to place the image between ‘Sincerely’ and ‘Roger Miller’.
The position and size coordinates of the image display in the Position and Dimension
toolbar. This object does not need to be placed precisely, so you will not enter
specific coordinates.

The signature adds to the overlay.
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Drawing a Box
Next you will create two boxes to frame the CCBContact text. These boxes will separate
the bank contact information visually from the body of the letter.

55 On the Tools toolbar, click

.

The Box toolbar displays and the cursor changes to

.

Make sure the Square Lock
is not selected on the Box toolbox. The
Square Lock draws only squares, where the dimensions of all four sides are equal.
This overlay needs a rectangle.

56 Click and drag to draw a Box around the CCBContact text in the Design Area.

The rectangle displays around the text.

57 Right-click the Box and select Properties from the pop-up menu.
The Properties – Box dialog displays.
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58 Select the Transformation category and specify the following coordinates:





Width: 5.60
Height: 1.15
X: 1.50 in
Y: 8.65 in

Click Apply at any time to see your changes take effect.

59 Select the Style category and specify the line thickness:
Thickness: 1 ½ pt
The default system setting for unit of measurement is inches. If you enter a value
using another unit, the entry box automatically converts it to the system’s unit of
measurement.


Setting line thickness

The object-sensitive property dialog in DesignPro Tools provides design
properties for any selected object in the Design Area.
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60 Click Apply, and then click OK.

The rectangle displays around the text.
Now you will create a second Box that is slightly larger than the first one.

61 Right-click the first Box and select Copy from the pop-up menu that appears.
62 Right-click in the Design Area and select Paste.
A second Box pastes in the Design Area.
If you want to draw more than one box at a time, double-click the tool.
Otherwise, the system resets to the Select Mode tool after adding an object. For
example, if you want to draw two boxes, double-click
and paste to continue creating boxes.

. You can also use copy

63 Select the new rectangle and set the following specifications in the Position and
Dimension toolbar:
 X: 1.25 in
 Y: 8.46 in
 W: 6.10 in
 H: 1.55 in

The Position and Dimension toolbar.
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64 On the Common Attributes toolbar, select 1/2 pt in the Line Thickness drop-down
list.

The Common Attributes toolbar.

The boxes are complete.

Drawing a Line
The overlay also requires one horizontal line in the middle of the CCBContact text.

65 On the Tools toolbar, click
The cursor changes to

.
.

66 On the Line toolbox, click

.
You can now draw horizontal lines only.

67 Click and drag to draw a horizontal line between ‘Ventura, CA 93001’ and
‘www.CentralComBank.com’ in the Design Area.

The line drawn within the text box.
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68 In the Position and Dimension toolbar, specify the following coordinates:
X: 1.90 in
 Y: 9.36 in
 W: 1.65 in
The line is positioned and resized based on the specified coordinates.


You can also draw the line freehand instead of using coordinates.

69 In the Line Thickness drop-down list, select 1 ½ pt.

Selecting the line thickness in the Common Attributes toolbar.

70 Press Ctrl + S to save the overlay.
The overlay is complete.

Saving as an AFP Overlay
Now you will save the overlay and all of its resources in the AFP format. You will need
the overlay in the AFP format when printing.

71 From the File menu, select Save As.
The Save As dialog displays.

72 In the Save As drop-down list, select AFP Overlay Object (*.ove;O1*).
The path updates to drive:\Elixir\Forms\Afp, if the Elixir icon is selected in the left
pane. The Edit Property Settings and Restore default settings buttons become
available in the Save As dialog.
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73 Click Edit Property Settings.
The AFPDS dialog displays.

74 Specify the following properties:






Main category
Resolution: 300 R-Units
The resolution selected must match the target printer’s resolution.
Record Format: AFPDS
The AFPDS format creates MO:DCA files for use in AIX, InfoPrint, and PC
environments (NT) for transfer to MVS and VM hosts using IBM’s AFP
reblocking utility. The AS400 format creates AFP format files for uploading to
AS/400 hosts. The VBM format creates files formatted for transferring to MVS
and VM hosts using IBM 3270 (IND$ File) compatible file transfer packages.
For a standard file transfer to an OS/390, use the VBM setting. Refer to the
DesignPro Tools Online Help for more information about record formats.
External Resources,
Destination Directory: Default (from Profile Server)
External resources are resources that are not in the AFP format. DesignPro Tools
converts external resources to the AFP format during the save process. The
DesignPro Tools Online Help contains descriptions of all settings in the AFPDS
dialog.
Colors category
Color Format: Full Color (CMYK)
The selected color format must be supported on the target printer.
Fonts category
Map Coded Font: MCF format 2
Select Coded Font Name from the drop-down list
Include Font Resources: To External Resource File
When you select To External Resource File, you are choosing to save the
fonts to the AFP format at the same time you save the overlay to the OVE format.
You do not need to save the images since they are already page segments.
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Images category
Include Images: Never
Page Objects category
Overlapping Objects (with unsupported mixing mode): select All rasterize to
image (if checked conversion takes more time)
Selecting this option raterizes all overlapping objects and requires greater
conversion time.

Selecting the All rasterize to image option.

75 Click Apply, and then click OK to close the dialog.
76 In the File Name entry box, verify that the name is O1CCBLET.
AFP Overlays use the prefix O1.
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77 Click Save.
You return to the Design Area, where the Messages window displays the successful
conversion of external resources to AFP format. The overlay and its resources save
to the required format.

The Messages window displays any messages generated by the saving process.

78 From the File menu, select Exit.
Form Editor closes.

To clear the messages in the Messages window, use the shortcut keys Ctrl + D.
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Creating an Application
Now you will continue the application in Visual PPFA. Here you will create the PageDef
and FormDef for printing the Central Commercial Bank application. The letter is only one
page per document, and prints Simplex.

Simplex is the term for printing on one side of a sheet and Duplex is the term for
printing on both sides of a sheet.

From the Start menu, select All Programs, Elixir Applications, DesignPro Tools,
DesignPro Visual PPFA.
Visual PPFA opens.

Opening a New PageDef
First, you will build the logical page. The logical page determines where and how the data
will print. This is determined, in part, by the data layout.
CCB’s data is a simple line dataset with channel controls. You will use a traditional
PageDef to create the letter application.
Visual PPFA supports Traditional and Record Format PageDefs. Record Format
PageDefs are used for datasets prefixed with 10 byte Record IDs that can contain
delimited records.

The data file is in the EBCDIC format and cannot be viewed in Notepad. Use an
EBCDIC viewer such as UltraEdit or the mainframe to view your EBCDIC data
files.
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The CCBIntro dataset for the letter.

1

From the File menu, select New.
The New Resource dialog displays.

The New Resource dialog.

Chapter 4: Quick Start

121

2

Select PageDef Traditional, and click then OK.
A new Traditional PageDef opens.

A new traditional PageDef opens in Visual PPFA. 1. Menu bar. 2. Standard
toolbar. 3. View toolbar. 4. Position and Dimension toolbar. 5. Project toolbar. 6.
Filter toolbar. 7. Insert toolbar. 8. PageDef Tree 9. Template tree. 10. Design
area. 11. Messages window.

3

Close the Messages window by clicking

in the upper right corner of the window.

The Messages window will reopen when the system generates a message.
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Setting PageDef Properties
PageDef properties describe where and how to place data in the application. These
properties include the size of the logical page, the printing resolution, and the line spacing
for data.

4

Right-click New PageDef in the PageDef tree and select Properties from the pop-up
menu.
The Properties – PageDef dialog displays.

5

In the General category, specify the following:
 Name: CCBLET
 Alias: CCB Letter PageDef
The Alias name displays in the PageDef tree.

6

In the Margins category, specify the following properties:
 Lineone:
Horizontal: 0.10
Vertical: 0.10
 Linespacing: 6.00 LPI
 Pels Per Inch: 300

Setting margins for the PageDef.

The first data record starts printing using the Lineone value, relative to the
logical page.
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The Default unit for PageDef is inches. To change the default unit of
measurement, select Options from the Tools menu. Select the Ruler category
and use the Units drop-down list to select a unit of measurement.

7

Select the Dimensions category, and verify the following settings:
 Width: 8.30
 Height: 10.80
This is the dimension of the logical page, not the paper placed in the printer. The
logical page is not confined to the boundaries of a physical page until it is combined
with a FormDef at print time.

8

Click Apply, and then OK to close the dialog.
You have set the PageDef properties.

Inserting a Template Overlay
PageDefs place data on the physical page. The physical page may be pre-printed paper, or
an overlay with static graphic elements. In any case, it is easier to visually create the
logical page if you have a template of the physical page onscreen.
For the CCB letter, you are placing data in relation to the CCB overlay. Before inserting
the template, you will need to tell Visual PPFA how to read the template file. This can be
done by specifying the resource searching order in the Application Format Setting. You
will insert the AFP overlay just saved in the Form Editor, so Visual PPFA needs to know
that it is an AFP file.

9

From the Tools menu, select Application Format Setting, Elixir Properties.
The Elixir dialog displays.

The Resources category has two boxes in the Resource searching area: Available resource
converters and Resource Searching Order. You will make the AFPDS converter available
by moving it to the Resource Searching Order box.
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10 Select AFPDS in the Available Resource Converters box.
11 Click

between the two boxes to move AFPDS to the Resource Searching
Order box.

12 Click

to the right of the Resource Searching Order box to move AFPDS to
the top of the list.
The Elixir properties are complete.

Adding AFPDS to the Resource Searching Order.

13 Click Apply, and then click OK to close the dialog.
Now you are ready to insert the template overlay.

14 Select Template Overlays in the Template tree.
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15 On the Insert toolbar, click

.

The Overlay dialog displays.

Selecting the CCBLet overlay for a PageDef template.

16 In the Files of Type drop-down list, select AFP Overlay Object (*.ove;*.ovl;O1*).
If the Elixir icon is selected in the left pane of the dialog, the overlay dialog displays
the DesignPro Tools default directory for AFP overlays: drive:\Elixir\Forms\Afp.
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17 Select O1CCBLET.ove, and click Open.
The overlay loads as a template.

The template overlay loads in Visual PPFA.

Creating a Font List
Font lists organize fonts required for the PageDef. Although you can add or delete fonts as
you create the PageDef, it is best to set up the font list before adding data so that the fonts
are available when you need them.
When you saved the overlay, the True Type fonts used in the overlay were saved to AFP
format. For building the PageDef, you will use AFP fonts.

Overlay and PageDef resources use separate font lists.
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18 Right-click Font List in the PageDef Tree and select Properties from the pop-up
menu.
The Properties – Font List dialog displays.

The Properties – Font List dialog lists one default font.

AFP fonts can be used in Visual PPFA without any pre-conversion.

128

DesignPro Tools® for AFP Getting Started Guide

19 Click Add/Remove Fonts.
The Font List Dialog displays.

Font List Dialog also lists the default font.
This application requires only one font: X0AR11NP. You will replace the default True
Type font with this AFP coded font.

20 With the default font selected, click

and select Coded font.

The Open Resource File dialog displays.

21 In the Files of Type drop-down list, select AFP Coded Font
(X0*,X1*,X2*,X3*,X4*), if it is not already selected.

A Coded font references the Character set and Code page for a specific font.
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22 Click the Elixir icon in the left pane to automatically browse to
drive:\Elixir\Fonts\Afp.
The Elixir icon automatically locates the default directory for AFP coded fonts from
the open profile. The coded fonts that were created when you saved the CCB overlay
display in the Open Resource File dialog. The system named these fonts
automatically during the save process.

Selecting the Arial 10 AFP coded font.

23 From the Coded font list, select X0AR11NP.
This naming convention refers to an AFP Coded font (X0), Arial (AR), 11 point (11),
normal style (N). The extra P was originally used to denote rotation, but AFP
Bounded Box fonts include all rotations in one font.

130

DesignPro Tools® for AFP Getting Started Guide

24 Click Open.
The default font updates to reference the new font. The default font automatically
applies to each new record or field.

The default font is replaced with X0AR11NP.

The default font in a PageDef should always be available in the FontLib on the
host. The printing process will be interrupted if you accidentally use a font in a
PageDef that is not in the FontLib.

Replacing the default with the most commonly used font streamlines the
application building process.
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25 Click OK to close the Font List dialog.
You return to the Properties – Font List dialog.

26 Click OK.
The AFP version of Arial 11 point font is set as the default font for the CCB
application.

Setting PageFormat Properties
A PageFormat describes a single logical page. Since this is a one-page application, you
will set the PageFormat to match the PageDef settings.

27 Right-click New PageFormat 1 in the PageDef tree window and select Properties
from the pop-up menu.
The Properties – Page Format dialog displays.

28 In the Margins category, specify the following properties:




Lineone
Horizontal: 0.10
Vertical: 0.10
Accuracy
Line spacing: 6.00 LPI
Pels Per Inch: 300

29 In the Dimensions category, verify the PageFormat size:
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Width: 8.30
Height: 10.80
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30 In the Display category, specify the following properties:
Horizontal: 0.10
 Vertical: 0.10
The Display values in the PageFormat represent the offset values in the FormDef.
These values in the PageFormat are not saved to the AFP format, and are not used at
print time.


Setting the PageFormat’s Display offset.

31 Click Apply, and then click OK to save changes to the PageFormat.
Display offsets position the PageFormat on the FormDef. These offsets are only
used for Visual PPFA display in the absence of a FormDef and will not be used at
print time.

Loading the Dataset
The boundaries of the logical page are set. Now you are ready to add the variable data to
the page. Data is added by specifying the data location in each record, or by dragging and
dropping data from a sample dataset. You will drag and drop data from the dataset for this
application.
Always use a small sample dataset in Visual PPFA, representative of the full
dataset. A large dataset can take a long time to load into the memory and may
slow the system.

Chapter 4: Quick Start

133

32 On the Project toolbar, click

.
The Open Sample Data File dialog displays.

33 Click

.

34 In the Files of Type drop-down list, select All Files (*.*).
35 Browse to select drive:\Elixir\Gs\CCBIntro.ebc and click Open.
You return to the Open sample data file dialog.

36 Specify the following additional settings:
File format: EBCDIC
 Control Characters: Carriage Control
The data is in the EBCDIC format and includes carriage controls. Visual PPFA needs
to recognize the structure of the data in order to read it correctly.


Selecting and defining the CCBIntro dataset.
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37 Click OK.
The dataset loads in the Sample Data window. The Messages window logs the
successful loading of the dataset.

The CCBIntro dataset loads.

Data Placement
As you build the logical page, the data placement displays on the template overlay. For
this project, you will click and drag all of the data onto the page, then go back and define
an exact position for each data element.
The PageDef automatically opens with one record. You will use this record to place the
first record in the dataset.
Visual PPFA can display the dataset as you build your logical page. You can drag
and drop records and fields from the Sample Data window onto the Design
Area.
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38 Right-click NewRecord 1 and select Include In Presentation from the pop-up
menu.
The first record highlights in the Sample Data window and displays in the Design
Area. The default information for NewRecord1 uses the first record from the dataset,
and places the record at the top left of the logical page.

The date record adds to the application.
The data file uses a channel control (CC) character to mark the beginning of each new
document. You will need to specify the channel control in the new record.

39 Right-click NewRecord 1 and select Properties from the pop-up menu.
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40 Select the Position category and set the Channel value to 1.

Setting the Channel value.

41 Click Apply, and then click OK.
You will specify positioning after all of the records are added to the page.
You will now add the remaining records for the PageDef. The remaining records do not
contain a channel control; since zero is the default value for Channel value, you do not
need to change the properties for the remaining records. Select the address rows (rows 24) in the Sample Data window.
To select multiple rows, click on a row number and drag down while holding the left
mouse button. The rows highlight in the Sample Data window.

The address records selected in the Sample Data window.
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42 Drag and drop the selected address rows onto the Design Area below the CCB logo.
To drag and drop, place the mouse over the row numbers until your cursor changes to
the move cursor. Then click and drag onto the Design Area. The first row of the
selected data repeats three times in the Design Area. A new record node named
NewRecord2 adds to the PageDef tree.
The mapped record shows the first line repeated three times in the Design Area,
because the PPFA language describes the record as Record 2 repeating for 3
records. The three lines of data will proof and print as shown in the Sample
Data window.

43 Select the next record, which includes Mr. Smythe, in the Sample Data window.
Select the row number to select the entire record.

44 Drag and drop the selected data next to ‘Dear’ in the Design Area.
NewRecord 3 adds to the PageDef tree.

The name record displays in the Design Area.
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Setting Record Positioning
You have added all of the data to the page. Now you will position the data so it prints
correctly.

45 Select NewRecord 1.
46 In the Position and Dimension toolbar, specify the following:
X: 1.15 in
Y: 1.45 in
Use the Enter key after typing in each coordinate to apply the setting to the record.
The record settings for the date are complete.



Now you will set the record properties for the address block and the salutation.

47 Select NewRecord 2 and specify the following in the Position and Dimension
toolbar:
 X: 1.15 in
 Y: 2.10 in
The record settings for the address block are complete.

Select the record either in the PageDef tree or in the Design Area. Then set the
position in the toolbar.

48 In the Position and Dimension toolbar, specify the following for NewRecord 3:



X: 1.52 in
Y: 3.40 in
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The record settings for the salutation are complete.

The data records are positioned correctly on the page.

If you wish, you can add record names by right-clicking a record node, selecting
Properties from the pop-up menu, and adding a name in the General category.

Saving the PageDef
The PageDef is complete. Before you add a FormDef to the application, you will save
your work in the Elixir format. The Elixir format saves some information that PPFA does
not support, such as record names, internal comments, and environmental settings. You
will also save the PageDef to the Object format for printing.

Visual PPFA supports both source and object formats. A separate compiling step
is not required

49 From the File menu, select Save, PageDef.
The PageDef Save As dialog displays.
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You can also use the keyboard shortcut Ctrl + S.

50 Browse to drive:\Elixir\Jobs\Elixir to save your PageDef.
This is the default profile’s location for Elixir PageDefs. If you have Elixir PageDefs
selected as your file type, and the Elixir icon selected in the left pane, this path is
already selected for you.

51 Enter CCBLET in the File Name entry box.
52 In the Save As drop-down list, select Elixir PageDef (*.epd) if it is not already
selected.

The PageDef Save As dialog.

53 Click Save.
The PageDef saves in the Elixir format. The Messages window confirms the file is
successfully saved.
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Now you will save the finished PageDef to AFP object format.

54 From the File menu, select Save As, PageDef.
The PageDef Save As dialog displays.

55 In the Save As drop-down list, select AFP PageDef Object (P1*.obj).
The PageDef Save As dialog displays the DesignPro Tools default directory for AFP
PageDefs: drive:\Elixir\Jobs\Afp.

56 In the File Name entry box, enter P1CCBLET.

Saving the PageDef to the AFP Object format.

PageDef names start with a “P1” prefix.

57 Click Edit Property Settings.
The AFPDS dialog displays.
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58 Specify the PageDef properties:


Main category
Resolution: 300 R-Units
Record Format: AFPDS
External Resources, Destination Directory: Default (from Profile Server)
The AFPDS format creates MO:DCA files for use in AIX, InfoPrint, and PC
environments (NT) for transfer to MVS and VM hosts using IBM’s AFP reblocking
utility. Refer to the DesignPro Tools help for more information about record
formats.





Colors category
Color Format: Full Color (CMYK)
The selected color format must be supported on the target printer.
Fonts category
Map Coded Font: MCF format 2
Select Coded Font Name from the drop-down list
See the DesignPro Tools help for more information on PageDef property settings.
All resources should have the same settings, and these settings should match your
printer’s capabilities.

59 Click Apply, and then click OK to accept the settings.
The AFPDS dialog closes.

60 Click Save.
The PageDef saves in the AFP format. The Messages window confirms that the file
is successfully saved. Note that the Elixir format PageDef remains open in Visual
PPFA.

Adding a FormDef
The next step is to define the physical page, or how the application prints. You will add a
FormDef to the already opened PageDef.
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FormDefs and PageDefs can be developed independently or together.

61 On the Project toolbar, click

.
The FormDef tree window adds to the workspace.

The FormDef tree displays.

Once you add a FormDef, the Template Overlay is no longer visible in the Design
Area. Notice the tabs underneath the new FormDef tree. You can switch back
and forth from the Template Overlay to FormDef using these tabs.
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Setting FormDef Properties
The FormDef properties tell the printer how to print an application. In simple terms, a
FormDef tells the printer what type of paper to use, how that paper prints (one-sided or
two-sided), and what overlays (static information) print.
The CCB application prints simplex, using a portrait orientation and one overlay.

62 Right-click New FormDef and select Properties from the pop-up menu.
The Properties – FormDef dialog displays.

63 In the General category, set the following properties:



Name: CCBLET
Alias: CCB Letter FormDef

64 Select the Offset category and verify the Front Offset:
Horizontal: 0.10
Vertical:0.10
Offset coordinates position the logical page, or the PageDef, on the physical page.
These offsets will replace the Display offsets set in the PageFormats.



The Back Offset settings become available if some kind of Duplex setting is
applied.
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65 Select the Presentation category and verify the following settings:




Presentation: Portrait
Direction: Across
Duplex Printing: Simplex

The FormDef’s Presentation properties.

Presentation is another word for orientation. Presentation orients the page and
Direction orients the printing.

66 Select the Print Control category and specify the following properties:


Pels per inch: 300

67 Click Apply, and then click OK.

Setting CopyGroup Properties
A CopyGroup typically defines a complete page or paper. It can be Simplex or Duplex,
and can have different properties than the FormDef. You should review all of the default
properties to make sure they are correct for the application.
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For the CCB application, the offset coordinates for the CopyGroup are the same as for the
FormDef.

A FormDef must have at least one CopyGroup. The CopyGroup determines one
set of physical characteristics for a page.

68 Right-click New CopyGroup 1, and select Properties from the pop-up menu.
The Properties – CopyGroup dialog displays.

69 In the Offset category, verify the Front Offset:



Horizontal: 0.10
Vertical: 0.10

70 In the Presentation category, verify the following:


Duplex Printing: Simplex

71 In the Print Control category, specify the following:


Pels per inch: 300

72 Click Apply, and then click OK.

Setting SubGroup Properties
A CopyGroup defines one or more sheets, each processing the same data. A SubGroup
defines special handling for individual sheets within the group. The most common special
handling is adding an overlay to a sheet. For a Simplex application, there is usually only
one SubGroup, defining the front side of the page.
For this application, you will set up one SubGroup.

73 Expand the CopyGroup by clicking on

next to New CopyGroup 1.

74 Right-click NewSubGroup 1, and select Properties from the pop-up menu.
The Properties – SubGroup dialog displays.
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75 Review the properties for the SubGroup.
You will keep all default values.

The SubGroup properties for this application uses the default values.

76 Click OK to close the dialog.

Inserting Overlays
Once you have defined the page, you can add overlays. The CCB application uses the
overlay created earlier in this exercise. For the FormDef, you will use the compiled AFP
overlay.

77 Select NewSubGroup 1, and click

on the Insert toolbar.

The Overlay dialog displays.
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78 Browse to select drive:\Elixir\Forms\Afp\01CCBLET.ove and click Open.
The overlay loads in the Design Area and lists in the FormDef tree.

The CCB Letter overlay loads.

Saving the FormDef
The FormDef is complete and ready to save. You will save the FormDef to the Elixir and
AFP formats. You will start by saving the FormDef to the Elixir format.

79 From the File menu, select Save, FormDef.
The FormDef Save As dialog displays.

You can also use the keyboard shortcut Ctrl + M.

80 In the FormDef Save As drop-down list, select Elixir FormDef (*.efd) if it is not
already selected.
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81 Click the Elixir icon to browse to drive:\Elixir\Jobs\Elixir.
This is the default profile’s location for Elixir FormDefs.

82 In the File Name entry box, enter CCBLET.
83 Click Save.
The CCBLET FormDef saves to the Elixir format. The Messages window confirms
the file is successfully saved.
You will now save the FormDef to the AFP format.

84 From the File menu, select Save As, FormDef.
The FormDef Save As dialog displays.

85 In the FormDef Save As drop-down list, select AFP FormDef Object (F1*.obj).
The FormDef Save As dialog displays the DesignPro Tools default directory for AFP
PageDefs: drive:\Elixir\Jobs\Afp.

86 In the File Name entry box, enter F1CCBLET and click Save.

FormDef names start with an “F1” prefix.

The FormDef F1CCBLET saves to the AFP format with default settings. The Messages
window confirms that the file is successfully saved.

Proofing Your Work
Now you will set up Visual PPFA for proofing. A proof combines the overlay, PageDef
and FormDef with your sample data file. You can do this onscreen in Visual PPFA.
For Visual PPFA to proof your application, it needs to have all of the information for
proofing in one place. To define all of the information for proofing:

87 From the Project menu, select Proofing Settings.
The AFP Proofing dialog displays.

88 In the General category, specify the following properties:
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Data File: browse to select drive:\Elixir\Gs\CCBIntro.ebc
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You will need to select All Files (*.*) from the Files of Type drop-down list to
view EBCDIC files.







File Encoding: EBCDIC
File Format: Stream NewLine
New Line Char: 0D0A
Carriage Control: Selected
Carriage Control Type: ANSI…EBCDIC
Carriage control characters, if present, are located in the first byte (column) of
each line in a dataset. They control how the line is formatted (single space,
double space, triple space, and so forth). In addition, other carriage controls can
position the line anywhere on the page. If there are no carriage controls, single
spacing is assumed.

Setting properties for proofing.
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0D0A is a carriage return/line feed in hexadecimal representation.

89 Click Apply, and then click OK.
Data proofing requires an open PageDef, an open FormDef and an open sample
data file. All resources must be in AFP format. There must also be at least one
object mapped in the PageDef. A mapped object prints on the page.

You can now run data proofing.

90 On the Project toolbar, click

.
A view of the merged document opens in the Viewer utility. Running proofing shows
data mapped according to the PageDef.

The completed data proof.
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You can scroll through the pages of the file using the Go toolbar.

Use the Go toolbar to scroll through the pages of the application.
When you are finished viewing the application, close the Viewer and Visual PPFA.

91 From the File menu, select Exit from the Viewer menu.
92 From the File menu, select Exit from the Visual PPFA menu.
You have completed the CCB Letter application.

Using Elixir PrintDriver Pro to Create Overlays
PrintDriver significantly reduces the time required to create overlays by printing overlays
directly from a source application. It is an interactive tool that uses the Windows Print
function to create overlays in any of the supported formats. PrintDriver creates documents
using tools you are familiar with, such as MS Word, and then exports those documents to
formats supported by DesignPro Tools.
In this chapter, you will use PrintDriver to “print” a Microsoft Word document into the
EFR format. You will then open the overlay in Design Form Editor, make a few
modifications, and save the edited file.

Creating an Overlay from an MS Word Document
Creating an overlay using the Print Driver is very simple. The PrintDriver option is
available in all of your Windows application Print dialogs. It displays in the Printer Name
list as Elixir PrintDriver Pro. For this exercise, you will open a DOC file in Microsoft
Word and select PrintDriver as your printer.
CCB’s marketing department just completed a mockup for a promotional letter in
Microsoft Word. For this exercise, you will open the MS Word document and print it to an
overlay. Then you will replace the logo, used by the mockup team, with the approved
print-ready CCB logo.

1

Open Microsoft Word.

2

From the File menu, select Open.
The Open dialog displays.
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3

Browse to open drive:\Elixir\Gs\Loan.doc.
Loan.doc opens.

The original mockup in Word.
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4

From the File menu, select Print.
The Print dialog opens.

Printing from Microsoft Word.

5

In the Printer Name drop-down list, select Elixir PrintDriver Pro.
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6

Click OK.
After a moment, the PrintDriver Wizard dialog displays. This dialog allows you to
convert your Word document into one or many output formats.

Setting conversion properties in the PrintDriver.

If the PrintDriver Wizard doesn’t display, then you may need to change some
PrintDriver settings.




7
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Browse to the directory drive:\Program Files\Elixir Technologies\Bin and
double-click PrintDriverOptionsAppU.exe. The PrintDriver Options
dialog opens.
Click on the Options tab, and then make sure that the Autorun (No
Windows, Messages to Log File) option is unchecked, and the Show
‘File and Format’ Setup at Start and Show Result Dialog Always
options are checked. Click OK to close the dialog.

Select Form as the Document Type.
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8

Specify the following settings in the first output row:
 Format: ElixirDoc
This will print the Word document to the Elixir format. The name and path of the
output file depend on the selected Format. In this case, drive:\Elixir\Forms\Elixir
is the target directory path for the EFR. The extension EFR will create an Elixir
form with an automatically generated filename.
 Output File: drive:\Elixir\Forms\Elixir\Loan.efr
The default DesignPro Tools path for Elixir format forms is already selected. You
can change this selection by clicking on Output File and clicking
to browse
for another location.
 Setup File: drive:\Documents and Settings\All Users\Application Data\Elixir
Technologies\Designpro Tools\elxdrv.epm
This is the default EPM file used for PrintDriver, created at the time of
conversion. You can click the Setup File entry box and
to browse for an
existing EPM file.
To view the EPM files properties, click Edit.
An EPM file stores settings for conversions. For more information on EPM files,
see the DesignPro Tools Online Help.
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9

Click Convert.
The PrintDriver Wizard displays the Conversion Result. The Word document has
converted to an Elixir overlay.

Conversion results display in the PrintDriver Wizard.

If the PrintDriver Wizard displays a failed conversion error, you can click
Progress to view messages generated during conversion.

Now you will open the converted document in Form Editor, and make changes to the
newly created overlay. You will see that the PrintDriver overlay and the original Word
document are identical.
PrintDriver automatically generates a filename for each file it creates, if you do not name
the file in the PrintDriver Wizard. Each new filename increments alphabetically to avoid
file overwrite. The first overlay file created is Daa.efr. Subsequent files are automatically
incremented and named Dab.efr, Dac.efr, etc. The system will continue to increment up
through the alphabet indefinitely.
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For multiple page documents, the filename is appended with a numeric at the end of the
file’s stemname. For example, if a certain file contains three pages, three EFRs are
created, named Daa.efr, Daa1.efr, and Daa2.efr. If you print a file using the same name,
the system automatically overwrites the existing file.
It is recommended that you periodically delete files converted by PrintDriver that
are not in use. Please note that the system will continue to increment the
filenames, even though you may have deleted all of the previously converted files.

Making Modifications to a Printed Form
Next, you will open Form Editor and change the logo in the new form, which is named
loan.efr. You will see that the Elixir form and the original Word document are identical.

10 Switch back to the Form Editor.
Form Editor should be open from the previous exercise.

11 From the File menu, select Open.
12 In the Files of Type drop-down list, select Elixir Form (*.efr).
If the Elixir icon is selected in the left pane, the directory path automatically updates
to drive:\Elixir\Forms\Elixir.
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13 Select Loan.efr, and click Open.
Loan.efr opens in the Design Area.

The file after converting to the Elixir format.

14 Click Close in the PrintDriver Wizard dialog.
15 Close Microsoft Word.
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16 Select the CCB logo, and press Delete on your keyboard.
The logo deletes from the overlay, and the associated image reference is also
removed from the Resource Manager tab in the Manage window.

The Resource Manager tab in the Message window displays the references of all the
images present in the overlay. (1) The reference of CCB logo is being displayed in
the Resource Manager under the Images node. (2) The Resource Manager tab after
the CCB logo is deleted from the overlay.

Adding a New Image
You will add the CCB logo as the final step to complete the overlay.

17 On the Tools toolbar, click

.
The Open Resource File dialog opens.

18 In the Files of Type drop-down list, select AFP Page Segment (S1*).
If the Elixir icon is selected in the left pane of the dialog, the path automatically
updates to drive:\Elixir\Pics\Afp.

19 From the Insert As drop-down list, select Embedded.
20 Select S1CCLogo.seg and click Open.
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21 Place the logo using the following coordinates:



X: 0.30 in
Y: 0.75 in

Use the Position and Dimension toolbar or the Properties – Image dialog
to place the image with the precise coordinates.

The overlay is complete.
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Print Preview
You can proof your work using Print Preview or by printing the file to a local or
networked desktop printer.

22 From the File menu, select Print Preview.

The completed overlay in print preview.

23 When you are finished reviewing the overlay, click Close.

Saving the Overlay
Now that your work is complete, you will save the overlay.

24 From the File menu, select Save.
The overlay is saved in the Elixir format and the overlay is complete.

25 From the File menu, select Exit.
You have completed the Quick Start exercises.
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EBCDIC 134
proofing 150, 152
proofing requirements 152
sample data file 133
datasets
Central Commercial Bank 120
opening 133
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placing 133, 135
design area 94, 122
DesignPro Font Editor, description 8
DesignPro Form Editor, description 8
DesignPro Graphics Editor, description 8
DesignPro Manager
description 8
opening 86
DesignPro Tools
AFPDS Tree See AFPDS Tree
applications 8
DesignPro Font Editor See DesignPro Font
Editor
DesignPro Form Editor See DesignPro Form
Editor
DesignPro Graphics Editor See DesignPro
Graphics Editor
DesignPro Manager See DesignPro Manager
DesignPro Visual PPFA See DesignPro Visual
PPFA
Editors 8, 85
Elixir PrintDriver Pro 8, 153
Elixir Scout See Elixir Scout
Elixir Viewer See Elixir Viewer
fonts, supported 100
Form Editor 94
installing 17
introduction 7
modifying 47
modifying the install 56
parsers 85
registering 30
repairing 54
resources 85
silent installation 68
silent modifying 75
silent repairing 78
silent uninstalling 81
silent upgrading 73
uninstalling 61
updating the install 42, 50
upgrading 39
Utilities 8
Visual PPFA 120
writers 85
DesignPro Visual PPFA, description 8
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dialogs
AFP Proofing 150
AFPDS 117, 118
Browse For Folder 88
Check/Uncheck to associate file extensions 37,
45, 52, 59
Choose Destination Location 24
Customer Information 22
DesignPro Tools Wizard 19, 41, 49, 55, 63
Elixir 124
Elixir Product Registration 30
License Agreement 20, 41
Log on As 26, 43, 57
Maintenance Complete 46, 53, 60, 66
New Resource 121
Open Resource File 97, 130
Open sample data file 134
Options 95
Overlay 126
PageDef Save As 141
Print 155
PrintDriver Wizard 156
Properties – Box 113
Properties – Font List 128
Properties – FormDef 145
Properties – PageDef 123
Properties – Record 137
Properties – SubGroup 147
Properties – Text 101, 109
Select Program Folder 25
Setup Status 29, 45, 52, 59, 66
Setup Type 21
Shared File Detected 65
Start Copying Files 28
Text Import 104
Welcome 64
dimensions 124, 132
direction 146
directory structure 85
DLLs
installing 24
shared 65
DOC 153
documentation
online 13
domains 27, 44, 58
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drawing
boxes 112
lines 115
rules 115

E
EBCDIC 134, 151
editing
forms 159
text 108
EFR 103, 153, 160
Elixir
Application Suite 108
dialog 124
forms 159
PrintDriver Pro 8, 153
resources 24, 100, 103, 141
Scout 8, 65
Viewer 8, 152
Viewer utility 152
Elixir Product Registration dialog 30
Elixir web site 13
ElixirDoc 157
embedded resources 97
EPD 141
extensions
BMP 96
DOC 153
EFR 103, 153, 160
EPD 141
ISS 68
OBJ 150
OVE 116, 149
RTF 104
TIFF 96
TXT 104

F
F1 150
file extension associations 37, 45, 52, 59
file management 8
Filter toolbar 94, 122
folder structures 85
Font Editor See DesignPro Font Editor
font lists 100, 127
FontLib 131

Index

fonts
Adobe Type Manager (ATM) 100
AFP 100
bounded box 130
coded 129, 130
Elixir legacy 100
font lists 127
mapping 143
MCF format 117, 143
naming conventions 130
outline 100
raster 100
references in overlays 117
True Type 100
Form Editor 96, 158
design area 94
Manage Window 94
Form Editor See also DesignPro Form Editor
FormDefs 120
about 91
adding 143
CopyGroups 146
offsets 145
overlays, inserting 148
presentation 146
properties 145
saving 149
SubGroups 147
Tree window 144
forms 103
modifying 159
saving 103

G
Go toolbar 153
Graphics Editor See DesignPro Graphics Editor
guides
DesignPro Form Editor for AFP User Guide 10
related 10

H
hardware requirements 16
compilers 16
hard disk space requirements 16
monitor requirements 16
print servers 16
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processor requirements 16
Ram requirements 16
screen resolution requirements 16
help
context-sensitive 13
customer support 12
Elixir web site 13
online help 13
related guides 10
release notes 14
hosts See mainframes

I
IBM
AFP standards 7
compilers 16
hosts 9
print servers 16
printing environments 9
images
adding 110, 161
AFP page segments 110
inserting 96, 110
placing 111
importing
images 96
text 104
InfoPrint
Manager 16
printer 117, 143
InfoPrint Manager
for AIX 16
for Windows 16
Insert Box tool 112
Insert Image tool 97
Insert Line tool 115
Insert Overlay tool 148
Insert Text tool 100
Insert toolbar 122
inserting
boxes 112
FormDefs 143
images 96, 110
lines 115
overlays 148
template overlays 124
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text 100
installing 17
modifying 42, 50, 56
removing 42, 50, 56
repairing 50, 56
silent mode 68
uninstalling 42, 50, 56
updating 42
Internet Explorer 15
introduction
DesignPro Tools 7
ISS 68

J
justification 110

L
legacy fonts 100
License Agreement dialog 20, 41
line spacing 110, 123, 132
lineone settings 123
lines 113
drawing 115
horizontal 115
properties 116
thickness 113
Log on As dialog 26, 43, 57
logical page
definition 120
dimensions 124

M
machine serial numbers 31
mainframes 9
Maintenance Complete dialog 46, 53, 60, 66
Manage window 94, 161
Manager See DesignPro Manager
mapping
data 135
fonts 117, 143
records 138
virtual folders 88
margins
category 123
imported with RTF 105
specifications 123
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Messages window 122, 135
Microsoft Word 153
MO:DCA files 117, 143
MO:DCA record formats 117, 143
modifying DesignPro Tools 47
MS Word See Microsoft Word
MVS hosts 117, 143

N
naming conventions, PrintDriver overlays 158
New Resource dialog 121

O
O1 116
OBJ 142, 150
offsets 145, 147
Open Resource File dialog 97, 130
Open sample data file dialog 134
opening
datasets 133
DesignPro Form Editor 94
DesignPro Manager 86
DesignPro Visual PPFA 120
PageDefs 120
operating systems 15
Options dialog 95
orientation 146
OS/390 16, 117
OS/400 16
outline fonts 100
OVE 116, 149
Overlay dialog 126
Overlay Generation Language 17
overlays 94
compiled 148
font lists 100
images 96
inserting into FormDefs 148
prefix O1 118
saving 103, 163
Template tree 125
templates 124

P
P1 142
Page Printer Formatting Aid See PPFA

Index

PageDef Save As dialog 141
PageDefs 120, 141
about 91
font lists 100, 127
new 120
object format 142
opening datasets 133
PageFormats 132
properties 123
saving 140
template overlays 124
traditional format 120
tree 122
PageFormats
dimensions 132
line spacing 132
properties 132
pages
logical 120
physical 143
properties 95
parsers 85
Password.epw 35
PC number 32
physical
folders 86
page 143
Position and Dimension toolbar 94, 99, 122
positioning records 139
PPFA 17
PPFA See also Visual PPFA
prefix
F1 150
O1 116
P1 142
S1 97, 110
presentation 146
previewing 163
print
preview 163
servers 16
Print dialog 155
Print Services Facility See PSF
PrintDriver
uninstalling 65
PrintDriver See Elixir PrintDriver Pro
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PrintDriver Wizard dialog 156
printing
direction 146
FontLib 131
FormDef settings 146
printstream display 8
product license
downloading existing license from Internet 35
preparing and downloading initial license from
Internet 33
viewing 35
profiles
multiple 89
relation to virtual folders 89
program folders 25
Project toolbar 122
proofing 163
PageDefs and FormDefs 150
requirements 152
properties
accessing 108
AFPDS 118
boxes 112
CopyGroups 146
FormDefs 145
lines 116
PageDefs 123
PageFormats 132
pages 95
records 137
SubGroups 147
text 101, 109
Properties – Box dialog 113
Properties – Font List dialog 128
Properties – FormDef dialog 145
Properties – PageDef dialog 123
Properties – Record dialog 137
Properties – SubGroup dialog 147
Properties – Text dialog 101, 109
PSF
for OS/390 16
for OS/400 16
for VM 16
for VSE 16
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Q
quick start application 92

R
raster fonts 100
records
AFPDS format 143
AS400 formats 117
carriage controls 137
channel controls 137
default positioning 136
MO:DCA formats 117, 143
placing data 133
positioning 139
properties 137
Sample Data window 136
VBM formats 117
rectangles 112
registration
deactivating the product license file 36
DesignPro Tools 30
downloading existing product license from the
Internet 35
downloading initial product license from the
Internet 33
run password registration process 19, 41, 49,
55, 63
using the Internet 33
viewing the product license information 35
related guides 10
release notes 14
removing
DesignPro Tools 64
software 64
virtual folders 90
repairing DesignPro Tools 54
requirements
hardware 16
software 15
system 15
resolution 117, 143
Resource Manager 161
resources 85
defining default paths 24
Elixir forms 159
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embedded 97
FormDefs 91, 120, 149
forms 94, 103
images 96, 110
legacy fonts 100
organizing using profiles 89
overlays 94, 96
PageDefs 91, 120, 141
reading 125
searching order 125
virtual folders 87
Rich Text Format files 104, 107
RTF 104, 107
margins 105

S
S1 97, 110
sample data 133
Sample Data window 135, 137
saving
as an AFP overlay 116
as an Elixir form 103
FormDefs 149
overlays 163
PageDefs 140
Scout
description 8
Scout See Elixir Scout
Select Mode tool 102
Select Program Folder dialog 25
Select toolbox 94
serial numbers 31
Setup Status dialog 29, 45, 52, 59, 66
Setup Type dialog 21
Shared File Detected dialog 65
silent mode
installing DesignPro Tools 68
modifying DesignPro Tools 75
repairing DesignPro Tools 78
uninstalling DesignPro Tools 81
upgrading DesignPro Tools 73
software requirements 15
Internet Explorer 15
Windows 2000 service pack 15
Windows NT service pack 15
Windows XP service pack 15

Index

squares 112
Start Copying Files dialog 28
styles 113
SubGroups
definition 147
overlays, inserting 148
properties 147
support 12
supported operating systems 15
system
parsers 85
writers 85
system requirements 15

T
Template Overlay tool 126
template overlays
inserting 124
Template tree 122
text
adding 100
editing 108
importing 104
inserting 100
justification 110
line spacing 110
properties 101, 109
selecting 108
Text Attributes toolbox 108
Text Import dialog 104
TIFF 96
toolbars
Common Attributes 94, 115, 116, 122
Filter 94, 122
Go 153
Insert 122
Position and Dimension 94, 99, 122
Project 122
Tools 94, 122
View 122
Zoom 94
toolboxes
Select 94
Text Attributes 108
tools
Insert Box 112
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Insert Image 96, 97, 110
Insert Line 115
Insert Overlay 148
Insert Text 100
Select Mode 102
Template Overlay 126
Tools toolbar 94, 122
training 13
True Type fonts 100
TXT 104
Typographic Conventions 10

XP 15
windows
Manage 94, 161
Messages 122, 135

Z
Zoom toolbar 94

U
uninstalling
DesignPro Tools 61
Scout 65
unmapping virtual folders 90
upgrading DesignPro Tools 39
utilities
Elixir PrintDriver Pro 153

V
VBM record formats 117
View toolbar 122
Viewer See Elixir Viewer
viewing AFPDS files 8
virtual folders
adding 88
and profiles 89
definition 86
organization 86
removing 90
Visual PPFA
data structures 134
design area 122
proofing 150
Visual PPFA See also DesignPro Visual PPFA
VM 16
VM hosts 117, 143
VSE 16

W
Welcome dialog 64
Windows
2000 15
NT 15
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